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Chapter 1: Introducing AMECustom

1.1 Presentation of this manual

The AMECustom user manual will help you to:

* understand the aim of AMECustom and what you can do with this
complementary application of AMESim,

* learn how to customize submodels and supercomponents.

This user manual is split up into four chapters:

Chapter 1 introduces AMECustom and customized objects.

Chapter 2 gives two examples of customized submodels.

Chapter 3 gives two examples of customized supercomponents.

Chapter 4 is a reference chapter which can be used from the main index.

We recommend that you go through these examples before you attempt your
own customizations.

1.2 What is AMECustom?

Before answering this question it is worth reviewing what you can do with each
product of the AMESim suite.

AMESim

You build models by connecting together components either directly
or using lines. In Submodel mode you attach mathematical descrip-
tions to each component and line. These are either submodels or su-
percomponents. You can then change parameters, perform runs and
analyze results.

You can also develop your own supercomponents.

AMERun

You cannot build models and supercomponents. But you can use mod-
els built from AMESim for changing parameters, performing runs and
analyzing results.
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AMESet

You create your own submodels for using them in AMESim models.

The submodels you create in AMESet and the supercomponents you create in
AMESIim are described as generic. When submodels are of a very general
nature, the number of parameters to set can be very large. This is even more
true for supercomponents. To overcome this problem the customized
submodels and supercomponents were introduced.

AMECustom

In AMECustom you load generic objects (submodels or supercom-
ponents) and then:

fix and hide certain parameters,
rename other parameters and set new default values,

link together two or more parameters with a global parameter having
a scope limited to the customized object,

hide certain variables,

retitle other variables and set new default values.

The result is a customized version of the generic object.

1.3 Customized submodels

An example of very simple level of customization of submodels is in the
Thermal Hydraulic library. The fluid properties submodels 7FFD1 and
TFFD?2 are generic submodels and associated with them are 10 customized
versions of TFFD/ and 10 customized versions of TFFD2.

Figure 1.1 shows the generic TFFDI with its 10 customized versions.
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Figure 1.1: TFFD1 has 10 customized versions

%} Submodel List [ 7]

thf_fluid_data - TFFD1

Currently component iz associated with
submodel TEFD

— Submodel list

Description

M amne

] [ all 1|

- TF_PURE_WATER thermal-hydraulic simple properties [polynomials)
- TF_PURE_GLYCOL thermal-hydraulic simple properties [polynomials)
- TF_DIESEL_SIMPLE thermal-hydraulic simple properties [polynomials)
- TF_COOLAMT_EG20WE0  themmal-hydraulic simple properties (polynomialz)
- TF_COQLANT_EGAMWED  themmal-hydraulic simple properties (polynomialz)
- TF_COQLAMT_EGEMZ0  themmal-hydraulic simple properties (polynomialz)

(i
(i
- TF_COQLAMT_EGEMA0  themmal-hydraulic simple properties (polynomialz)
- TF_COOLAMT_SIMPLE thermal-hydraulic simple properties (polynomialz) b
- TF_OIL_15w40 thermal-hydraulic gsimple properties [polynomialz)
- TF_OIL_18w30 thermal-hydraulic simple properties (polpnomialz) ;I
W Copy comman parameters when submadel changes
External vanables Help Erplore | Bemove |
oK I LCancel |

i

Figure 1.2 shows the generic submodel 7FFD/ in Parameter mode.

Figure 1.2: Generic submodel TFFD1 in Parameter mode

*. Change Parameters (7] x]

Submodel
TFFD1-1
External variablesl
thermal-hpdraulic simple properties
[polynomialz)
Available custormized submodel: | TFFD1 |
W Copy commaon paraneters when subrodel changes
—Parameters
| Titte | e [ it |
index of thermal hpdraulic fuid 1
initial temperature 20degC
niame of the fluid coalant
filename for fluid charactenstic data  $4ME Jdibthh/data/coolant data

Save | Defaultvalue | Ias, value |
Load | Eesettitle | F it sralue |
Help | Cancel | Ophionz > |
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A customized version is shown in Figure 1.3.

Figure 1.3:Customized version in Parameter mode

** Change Parameters EHE

Subrodel

TF_PURE_WATER-1

Esternal wanables |

thermal-hydraulic simple properties

[polynanmials)
Awailable cuztomized submodels: TF_PURE_WATER ;I
v Copy common parameters when submodel ch TEFD1 =
—Parameters TF_PURE_GLvCAL
I Tille IVaIueI LInitI TF_DIESEL_SIMPLE
o T hodraic fluid 1 TF_COOLAMT_EGZ0h¢E0
!”.t.eff B"“ta HarAlE fl 50 ot | TF-COOLENT_EG40WED
1Al Iemparature “0- | TF_COOLANT_EGBOW2D
TF_COOLAMT_EGEDW A0
TF_COOLAMT_SIMPLE e
5 | TF_OIL_15w40 -
2ave EEFEOERTE, EEE=En
Load | Heszet title | ki, walte |
Help | Ok LCancel | Optionz »> |

Note the pulldown menu allowing switching between generic submodel and
the 10 customized versions in Parameter mode. This does not involve any
recompilation and it can be done in AMERun as well as AMESim. Note also
the parameter list is shorter and simpler for the customized submodels.

This level of customization is very light but it is powerful and very valuable
especially in AMERun. All that has happened is that in each customized
versions, 2 parameters of the generic submodel are hidden. One of them is
fixed to the name of a data file which supplies the information on the fluid
concerned.

1.4 Customized supercomponents

When you customize a supercomponent, you make it appear in AMESim and
AMERunN as if it was a submodel. You can explore the contents of the
customized supercomponent only in AMECustom, but if in AMECustom
you saved it encrypted, you must supply the correct password to reopen it.

Customization can be multi-level: customized supercomponents can contain
other customized objects.
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1.5 Important rules for customized objects

Comments in this section are important but you may not fully understand their
significance at a first reading. We suggest you reread it after completing the
tutorial examples.

Customized submodels

For using a customized submodel in an AMESim model, the corresponding
generic submodel must be available, and in particular its compiled code (.o or
.obj) must exist.

Customized supercomponents

A customized supercomponent can be used in an AMESim model even if the
corresponding generic supercomponent is deleted or unavailable.

Encryption

The encryption of a customized object in AMECustom does not affect
anything in AMESim. However:

» Ifyoulookin the .spe and .sub files with an editor, you will find them rather
difficult to understand!

» Ifyou look in the .cir file created by AMESim, you will find that its
relevant sections are also encrypted.

» Using AMECustom, when you try to open an encrypted customized
object, you must enter the correct password before getting access to it.

Protection of encrypted objects

Working out the internal details of an encrypted customized submodel is
possible given time. Concerning an encrypted customized supercomponent,
without the corresponding generic supercomponent, it would be extremely
difficult.

Distribution of systems containing customized objects

AMESim is increasingly used as a model exchange software. Customization
with encryption is an important part of this process.

Suppose you send a compiled AMESim system containing one or more
customized objects to another user. The AMEPack facility in AMESim is
designed to make this easy.
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The user can run the system in AMERun. Using AMESIim it is also possible
to run the system, but if the executable has to be recreated, the following files
are needed:

» The object files of the generic submodels corresponding to the customized
submodels,

» The object files of the generic submodels used in the customized
supercomponent constituents.

However the following files are NOT strictly needed:

* Any .spe files and .c (or .f) files of generic submodels.

* Any .spe files of customized submodels.

* Any .spe and .sub files of any generic or customized supercomponents.

If confidentiality is important, use the above information to minimize the files
you send in the package.
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Chapter 2: Customizing submodels

2.1 Introduction

This chapter shows you how to customize AMESim submodels with simple

tutorial examples. However, before attempting to read this chapter and doing
the exercises, you should have experience at using AMESim and performing
simple simulations with standard AMESim submodels.

Name conventions

For generic submodels and supercomponents the following restrictions apply
to the names:

* Names must be of 4 to 23 characters comprising uppercase letters and
digits.

* The first character must be a letter.

For customized objects the rules are the same except that the characters -’

(minus) and ©_’ (underscore) are permitted. It is a good idea to use these freely
so as to make customized objects distinctive.

Please note also that:

* Inall the AMESim libraries, standard submodels and supercomponents
have the first digit in their name (if any) in the range 0 to 4, whether they
are generic or customized.

* Hence, if you create your own customized objects with names that contain
at least one digit and if the first digit is in the range 5 to 9, there will be no
risk of name clashes with existing standard objects.

2.2 Example 1: customized submodel of the co-
sine function

Objective:
* To create the simplest possible customized submodel.

The function submodel FX00 belongs to the Signal, Control and
Observers library. The icon it is associated with is shown. This 2 3{ {1 =1
submodel applies any user-supplied function of one variable x, to
the input signal on port 2. The result is the output f(x) on port 1. The
function f'is defined by the user in Parameter mode.
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A simple customization can be made to FX00 to produce COS50, which will
calculate the cosine of the input. We could also produce a sine version, an
absolute value version and indeed a whole collection of customized versions of
FX00.

For this simple example you will load the generic submodel FX00 into
AMECustom and customize it saving the resulting customized submodel as
COS50. 1t is a good idea to create a special directory or folder called tutorial
(for instance) and save all the customized submodels in this directory.

Step 1: Start AMECustom

Using Unix:

Talk to your system administrator who will show you how to set up your
working environment so that you get access to AMECustom. To start
AMECustom, in a suitable window change to the directory where you
wish to work (tutorial for instance) and type:

AMECustom

Using Windows:
Do one of the following:

» Select AMECustom from the menu Program P Imagine
AMECustom produced by the Start button, or

* Double click on the AMECustom icon on your desktop, or

*  Type AMECustom in a MS DOS Command window from the directory
where you wish to work (tutorial for instance).

The display shown in Figure 2.4: appears. It has been deliberately made similar
to AMESim and AMESet but there are small differences in the display and
AMECustom performs different functions. The main area is used to display
details of submodels and supercomponents that are customized.
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Figure 2.4: AMECustom main area

EAHEEustnm =] E3

File Edit Options Previews lcons Tool: Documentation Windows Help

| @ Wi e

Note: For the rest of the tutorial exercises, you should save all your
customized submodels in the same directory as the current one
(tutorial directory).

Step 2: Select the FX00 icon

At the left hand side of the AMECustom display are the .
Categories buttons. Select the Signal, Control and Observers F[ﬁi
category and then click on the standard f{x) icon.The dialog box

below appears:

Figure 2.5: f(x) submodel list

%% Submodel List

fofx
25 £ 1
—Submodel list
Marne | Dezcription I Tupe |

F00  output a prezcribed function of input generic submodel

External variahlesl Help | Erplore |

Cancel |

&

Select the submodel FX00 in the list and click on OK: Figure 2.6: shows the
new display.
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E AMECustom - [C:/UNNAMED_FX00] |_ (O] <]

Figure 2.6: AMECustom display with a submodel loaded

5% File Edit Options Previews lcons Tools Documentation ‘#indows Help

=18 %]

==

[Fee-8

- 1

4

| LINMAMED_F<00

1)

fofx

Change icon |

Brief dezcription:

|||:uut|:uut a prezcribed function of ir

Full dezcription

L

—E =temal items

Submodel global parameters:

Real Ijntegel |IEHt |

1| 3]

Mame |Title |L|nit |Minimum |Defa

2|

4] |

Add rew

B emoyve |

E ztemal wariables:

Fort | Title

| Llnitl Type | M irirnLnn | Defaultl '

wariable
wariable

1 function of input »  null
2 input tof[x] nll

&
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Step 3: Customize the generic submodel

The process of customizing submodels is largely a matter of filling forms. Here
you are going to alter the characteristics of the submodel FX00 to get our own

submodel COS50:

1. In the Brief description field, replace the current description by the
following: ‘computes the cosine of the input’. This field contains text,
which will be displayed when the submodel is selected in AMESim.

Figure 2.7: Brief description field

Brief dezcriptian:

|computes the cosine of the inpul

2. Click on the button labeled Full description and change the title and
description as shown in Figure 2.8:
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Figure 2.8: Full description
"ia Full Description EHE
-
TITLE : COS50
DESCRIPTION :

COSA0 applies a cosine function to the input signal on port 2
and the result iz the output on port 1

LISAGE :

PERAMETER SETTINGS :

DATE OF CREATIOMAAUTHOR :

INDEX OF REYISIONS - -
4| | _’IJ
Clear all I Generic dezcription Load default | From file |

oK | LCancel |
A

3. Inthe External variables table, modify the title of the two external variables
as follows:

Figure 2.9: External variable table

External wanables :

Title | Part | Lnit | Type
cozing of input | Trull  wariable
inpLt % 2rul variable

4. Select the Text parameters tab from the Internal items table and set the
default value of the expression in terms of the input x parameter to cos(x):

Figure 2.10: Internal variable table

Internal items :
arameters | |nteger parameters | Text parameters |<|b|

Title: | Defaut value | Hidden |
expression in berms of the input s coz(x) r

Then click on the check box of the Hidden column so that a tick mark Hidden
appears in it: ¥

Note: This point is important because in AMESim, the parameter will not
appear anymore in the submodel parameter list and its default value
will be used. Hiding a customized submodel parameter ensures
that its default value will always be used in AMESim.

11
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Step 4: Save the customized submodel
At this stage the customization is complete and you can save it by clicking on
the === button. This will produce the dialog box below from which you can

give a name to your customized submodel:

Figure 2.11: Submodel name and password

E Enter Mame and Password

Submodel narme:

OS50

[~ Save encrypted

Pagzword

Enter pasaword:

Canfirm password;

] LCancel

Putting a tick mark in the check box labeled Save encrypted is not necessary
for such a simple submodel. This feature will be covered in the last example of
next chapter. If you then click on OK, a file browser appears and you must
select an AMESim node directory for your customized submodel.

Figure 2.12: Directory of the submodel

Select a directory

Dy AMETest butorial

#-{=) Disque local {:} ;I
EIQ Disque local (D)
B[] ADCEEARF
{:I AMESetExample
=] AMETest
- E-C] ECUib
¥ Fartransubmodels
: ] Icons
{:l submodels

=l

{:I CarmmonRailCampleteSysten ;l

Note that if the directory you selected is not in the path list you will get the
following message:

12
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Figure 2.13: You can add the new directory in the path list

i Mot In Path List

@ d: Aametesttutanal directary iz nob inthe path list. 0o pow want to add ity
i

If you click on Yes, this directory will be added to your path list.

You can get a preview of the Change Parameters and Variable List dialog

boxes you would get in AMESim. Click on the buttons %? and I@‘ to get
the previews shown in Figure 2.14: and Figure 2.15: respectively:

Figure 2.14: Preview of the Change Parameters dialog box

iﬁ]AHESim Parameter Mode Preview EHE

— Submodel|

C0S50
2 = f=) -1 External variabIE$|

computes the cosine of the
input

— Parameters
Title |vaie [Urit |

Optiang »» |

Help |

Figure 2.15: Preview of the Variable List dialog box

] AMESim Bun Mode Preview EE

— Submodel

COS50
2 A f1) 1 Esternal variablesl

computes the
cozing of the input

—Wariables
Title | value [ Uit |
coszine of input | null full
inpLt null aull
Tirne:

Help |

13
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As you can see, the parameter list is empty since the only parameter of the
generic submodel is now hidden. It is set to cos(x) and cannot be changed by
an AMESim user. The variable list shows the customized names of external
variables.

Step 5: Use the customized submodel in AMESim

1. Start AMESim and build the small model shown in
order to test your new submodel: Q}_’i £

2. In Submodel mode you will get the Submodel List dialog box shown below
after selecting the f(x) icon, and after clicking on the cross that appears to
the left hand side of the list:

Figure 2.16: Submodel List dialog box

%} Submodel List Kl E3

fokx

25 fra b1

Currently companent
has no submodel.

—Submodel lizt

.. CO550 computes the cosing of the inout

¥ Copy common parameters when submodel changes

Esternal vanables Help | Explone | Hemave |

oK LCancel |
&

You can then select the customized submodel COS50.

If COS50 does not appear in the list, check your pathlist and update it as
necessary.

3. In Parameter mode, it is also possible to change between generic and
customized submodels. The submodel currently assigned appears in a field
and you can select another submodel from a list which is produced by
clicking on the arrow in this field:
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Figure 2.17: List of customized submodels

*" Change Parameters EE

Submodel

CO550-1

25 frz -1 External variables |

computes the cosing of the
inpLt

Aailable customized submodels:

[+ Copy common pararmeters when subm

Set the slope parameter of the ramp submodel (RAMPO0) to 2*P1/10.

4. In Run mode, start a simulation for 10 seconds with a communication
interval of 0.01 second and plot the output of COS50 against its input. You
should get the following curve:

Figure 2.18: Plot the output of COS50 against its input

1- COS50-1 cosine of input = [rull]

0.5 \ .
1GII\/I L AL R

r T T
0.0 1.0 20 30 40 5.0 .0 7.0

COS50-1 input » [rull]

As an extension to this first example, you could create other customized
submodels from FX00 such as: SIN50, ABS50, EXP50, etc.

2.3 Files associated with a customized sub-
model

Each generic submodel you use in AMESim (called NAME for instance) has
three associated files:

» The source file NAME.f or NAME.c.
» The specification file NAME.spe.
* The compiled version of the source NAME.o (or NAME.oby).

15
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If you edit this submodel with AMECustom, you can customize it according
to your needs and save it as a different name: CUSNAME for instance. For this
new submodel AMECustom will produce two new files which are:

* The customized specification file CUSNAME.spe.
* The customized description file CUSNAME.des.

If your customized submodel is encrypted, it is protected by a password.

2.4 Example 2: creating two customized sub-

16

models from a cam generic submodel

Objective:
* To construct more complex customized submodels.

The cam submodel CAM00 belongs to the Mechanical library.
The icon it is associated with is shown. This is a submodel of a
cam profile with cam follower. An ASCII file is read defining | 5 ;@mzﬂ
the linear displacement in mm of the contact point at various
angular displacements in degree in the range 0 to 360. The file
containing the cam profile is defined by the user in Parameter
mode.

A simple modification can be made to CAMO00 to produce INCAMS50 and
EXCAMS50, which will be used as inlet and exhaust cam respectively.

Step 1: Load the cam submodel into AMECustom.

At the left hand side of the AMECustom display are the Categories
buttons. Select the Mechanical category and then click on the ﬂH
standard cam icon shown. The following dialog box appears:
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Figure 2.19: Submodel list dialog box

%3 Submodel List

cam?2

2@3}1

—Submodel list

Marne | Dezcription

| Type |

CamO0

External variahlesl

zam ahd cam follower

Help |

generic zubmodel

Erplore |

Cancel |

&

Select the submodel CAMO00 in the list and click on OK: Figure 2.20: shows the

new display.

Figure 2.20: AMECustom main interface with submodel loaded

FY AME Custom - [C:/UNNAMED_CAM00] M= E3

5% File Edit Options Previews lcons Tools Documentation “windows Help

=18 x|

& &

|7 E &2

- [ I

|

i;’

| UNMARMED_CAROD

25@3}1 cam2
Change icon |

Brief dezcription:

|c:arn ahd cam follover

Full dezcription |

—Esternal items

Submodel global parameters:
Beal Ilnteger |1| 3
Name | Title [Urit ||
| +

External wariables:

Fort | Title
1 welacity of the cam follower M

1' I *

Internal items:

Internal wariables I Real parameters 4 | bl

Title -

angular digplacerment of the cam -

&

We are going to alter the characteristics of the submodel CAM00 to get our own
inlet cam submodel INCAMS50. Then we will do the same for the exhaust cam
submodel EXCAMS0.
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Step 2: Customize CAMO00 to produce INCAM50

1. Inthe Brief description field, replace the current

description by the following: ‘inlet cam and cam | Brief descriptiar:

follower’. This field contains text, which will be | [inlet cam and cam follawed

displayed when the submodel will be selected in
AMESim.

2. Click on the button labeled Full description and change the title and
description as shown below:

Figure 2.21: Full description

&a Full Description

-

TITLE : INCARBEO

DESCRIPTION :
This is a submadel of an inlef cam profile with cam follower,

An ASCI file iz read defining the linear displacement of the contact
paint [in rim] according to the angular displacement [in degrees, in the
range O to 360). Mate that ik thiz file, the displacement at the first
angle value must be equal to the displacement at the last angle value.

On port 1 the outputs are the linear speed in m/s and the displacement
inm, the input iz a force in M. O port 2 the output i a tarque in
M and the input iz a speed in resmin.

There are bwa internal variables comprizing an angular displacement state
variable in degrees and a coresponding angle converted to the range 0
to 360, -

1 | B

Clear all I Generic dezcription Loaddefaultl Fram file |

ok | Cancel |
4

3. Inthe External variables table, modify the title of the external variables
named displacement of the cam follower and velocity of the cam follower
as follows:

Figure 2.22: Modify the titles of the external variables

External wariables :

Title I Port I Lnit I Type

velocity of the inlet cann follower 1mds one-line macro variable
dizplacement of the inlet cam tollower Tm multi-line macro variable

Ideally we would replace the word cam in all parameters and variables with
inlet cam.

4. Select the Integer parameters tab from the Internal items table and set the
default value of the parameter / for linear splines 2 for cubic splines to 2.
Both integer parameters must be hidden:

18



AMECustom 4.2

User Manual
Figure 2.23: Check boxes in the hidden column
Internial ikems :
Internal wariables | Real parameters | Integer parameters I Tegt parameters |
Title | Minimum valuel b axirnurn valuel Defauilt valuel Hidden|
1 for linear zplines 2 for cubic splines 1 2 2
dizzontinuity handling for linear splines: 0in... I 1 1V

5. Select the Text parameters tab from the Internal items table and set the
default value of the parameter file of cam position function of angular
displacement to SAME/tutorial/data/inlet cam_profile.data or
%AME%\tutorial\data\inlet cam_profile.data.

Note that you can use a file browser for this by clicking on the button _I,
provided you know the value of the environment variable AME. Ensure this
parameter is also hidden:

Figure 2.24: Ensure text parameter is hidden

Internal items:
|nternal variables I Feal parameters | |nteger parameters | Text parameters I

Title | Detaul value | Hidden
file of cam position function of ... ZAME Z\utorialhdatasinlet_cam_profile.data ¥

6. At this stage the customization of the submodel is complete and you can

=]
save it by clicking on the Save button. This one will be called
INCAMS50 and put in your tutorial directory.

Step 3: Customize CAM00 to produce EXCAM50

Repeat the procedure above (points 1 to 6) for EXCAMS50 ensuring that in
points 1, 2 and 3:

* inlet cam is replaced by exhaust cam, and
» INCAMS50 is replaced by EXCAMS50

(Alternatively with INCAMS50 still loaded in AMECustom do File P> Save as
specifying EXCAM50 and then make the changes.)

Point 4 is identical and the result of point 5 is shown below:

Figure 2.25: Result of point 5

Internal ikems:
|ternal variables | Feal parameters | |nteger parameters | Text parameters I

Title | Detaul value | Hidden
file: of cam position function of... ZAME %\utonalidata\exhaust_cam_profile.data W

Step 4: Test your customized submodels in AMESim

1. Start AMESim and build the model shown in Figure 2.26: in order to test
your new submodels. You might get LCONI2 instead of LCON11
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depending on use of ‘flip’ operations but this is not important. Save this
model in your tutorial directory.

Figure 2.26: Build this model

2. Use the following parameters for the inlet and exhaust side:

Submodel Title Value

SPRO00A | spring force with both displacements zero 500
[N]

MAS005 mass [kg] 0.01
lower displacement limit [m] 0
higher displacement limit [m] 0.03

LSTPO0OA | gap or clearance with both displacements 0.1
zero [mm]
contact stiffness [N/m] 1.0e9
contact damping [N/(m/s)] 1000
penetration for full damping [mm)] 0.01

3. Run a simulation for 0.08 second with a communication interval of 0.0001
second and plot the two cam displacements against their angular
displacement. You should get the following curves:
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Figure 2.27: Cam displacements against their angular displacement

1 - E=CAME0 displacement of the exhaust cam fallower [m]

2 - INCAMBD dizplacement of the inlet cam follower [m]

2 AR .

T
250
angular dizplacement of the cams [dedgree]

4. Save this model carefully because it is used again in next chapter.
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Chapter 3: Customizing supercomponents

AMECustom allows you to customize supercomponents as well as
submodels. In this chapter there are two examples.

In the first you construct a system which models a cam using mechanical and
control library components. You then convert it to a supercomponent. This
produces the same answers as the standard submodel CAM00. However, it is
not very convenient to use. To overcome this you customize it so as to make it
appear very similar to CAMO00.

In the second example you use a customized cam in a supercomponent of an
inlet and exhaust valve of a cylinder head. You then customize this to have two
levels of customization.

It is useful but not essential that you have some experience of using the /con
designer in AMESIim and/or AMESet.

3.1 Example 1: A customized cam
supercomponent

Objectives of the example:
» To illustrate the process of customizing a supercomponent.

* To compare a generic submodel, generic supercomponent and
customized supercomponent of the same component.

Figure 3.28 shows a system using the standard cam submodel CAM00.
Figure 3.28: System using the cam submodel CAMO00

(=S)aomedg  SUBMODEL CAMOO

Figure 3.29 shows the external variables of the cam submodel CAM00.

Figure 3.29: External variables of the submodel CAM00

= Nm = m/s
\ =*m
=+ ey min %:%_E‘_N

It is possible to produce the same results with the cam submodel replaced by
mechanical and control components. Figure 3.30 shows how this can be done.
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Figure 3.30: The cam submodel can be replaced by mechanical and con-
trol components

=Yoo  SUBMODEL CAMOO

=

FLAT SYSTEM

theta degree

2
mm m -
. .E: __-___-_IL
o I
2

mm/degree

----- —%@%* | force N

degree/s

We describe this as a ‘flat system’ because it is single level and will soon be
transformed into a supercomponent. A few words of explanation are needed.

Ignoring units by assuming everything is SI the logic is relatively simple. The
rotary speed w is integrated to produce the cam position 6.

0 = det

This is used with a table of values imported from a file to produce a
displacement x and the derivative dx/d6. From this we can recover the velocity
v as follows:
b _ o0 &

ot 006t 00

v

For a perfect transformer we have

R
Fv—F@w—Tw

From which
_
T =F 50
The four gains are needed to produce the correct units. Thus the table of values
used in CAMO0 and FXA10 give a cam lift in mm for angles in degree. This is
inconvenient from a modelling point of view but this is how data of this type is
normally presented!
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3.1.1 Constructing the flat system

Step 1: Construct both models in the same system

Step 2: Set the following parameters leaving all others at their default

values
Reference
Submodel number on Title [units] Value
sketch if any
GAO00 1 value of gain [null] 6
GAO00 2 and 3 value of gain [null] 0.001
GAO00 4 value of gain [null] 180/pi
PMO000 S5and 6 shaft speed [rev/min] 150
file of cam position
function of angular $AME/tutorial/data/cam.data
CAMO0 displacement
1 for linear splines 5
2 for cubic splines
FXA010 name of ASCII file $ AME/tutorial/data/cam.data

Step 3: Run a simulation and check that the results from the two models
are the same

Use a final time of 1 second and enable discontinuity printout.

Figure 3.31: Plot of the CAM00 and VELXCO submodels displacement

1 - CAMOO-1 dizplacement of the cam fallower [m]
2 -WEL=C0-1 linear displacement [m]

0.016—
0.074-] i
0012
0.010
0,008
0,006
0.004
0.002
0.000-

-0.00 T T T T T T T T T 1
[IR1] 0.z 0.4 0.6 0.s 1.0

Time [5]
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3.1.2 Constructing the generic supercomponent

Step 1: Convert the sub-system shown in Figure 3.32 to a generic
supercomponent using the cam icon

Figure 3.32: Sub-system to be converted to a generic supercomponent

FLAT SYSTEM

theta degree z m )
.—amoa.ﬁﬁd:i:?m_'—'—? ;'_
l o mm/degree | |
S ; |
5 -t s
ol 0000 .
torque Nm |

degree/s

Figure 3.33: Specify an icon, a name and a brief description

— Supercomponent creation

lcon 2 E@j:H Select an iconl

Mame IGENSUPERCAMSO

Brief
description

[generic supercomponent cam

Full descriptionl

Save |

Step 2: Add this to your AMESim system and check that it gives the same
results as the other two versions
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Figure 3.34: Generic supercomponent added to the AMESim system

GENERIC SUPERCOMPONENT

GEMSUPERCAMS0

Comparing the generic supercomponent with the generic submodel we have to
prefer the submodel. There are far too many redundant parameters in the
supercomponent which should be left at the set values. If we released the
supercomponent for others to use, sooner or later some of these values will get
changed. The situation is unsatisfactory so we will see what AMECustom can
do to improve matters.

The basic idea is to get the supercomponent to behave more like the submodel
CAMO00 hiding irrelevant detail. In particular we want the Change Parameters
and Variable List dialog boxes to be like those in Figure 3.35 and Figure 3.36
respectively.

Figure 3.35: Change Parameters dialog box

— Submodel

22€§Nﬂ}}1

CAMOD-1

External variablesl

Cam and cam follower

— Parameters
Title Value | it |
angular dizplacement of the cam Odegree
1 for linear zplines 2 for cubic gplines 1

dizcontinuity handling for linear splines: 0 inactive 1 active

1

file of carn position function of angular displacement

P:/&ME Sim/v4B etastutorial/data/cam. data
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Figure 3.36: Variable List dialog box

— Submodel
CAMOD-1
2 E@j:ﬂ Eutermal variablesl
Cam and cam
follower
— Wariablez
Title Value [urit | saved |
velocity of the cam follower Omds v
dizplacement of the cam follower Om I
force on the cam follower -2.22045e-011 W rd
torque an cam OMm v
rotary velocity of the cam 160 mvdmin - W
angular dizplacement of the cam 00 deqree W
angular dizplacement of the cam madula[3E0] 180 deqree ¥
tranzformer ratio Om 2

3.1.3 Customizing the supercomponent

experiments:

Step 1: Load the supercomponent into AMECustom. Try the following

Open the supercomponent tree structure as in Figure 3.37.

Figure 3.37: Supercomponent tree structure

camZ

| ¢

Change icon

Brief description:

Igeneric supercomponent cam

|

Full dezcription

—Supercomponent

Submodel Tupe I -
- < GEMNSIUPERCAMSD supercompanent
- FTON0 component
Feamnn component
Fa00 component
Ga00 carmpanent
G&00 component
Fa00 component
IMTO component
sewm A0 D00 o
of AL ST ——— ;I
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2. Click on the Explore button to produce the Explore Supercomponent dialog
box part of which is shown in Figure 3.38. Click on individual constituents
of the supercomponent and note how the corresponding item gets selected
in the supercomponent tree.

Figure 3.38: Constituents of the supercomponent

FLAT SYSTEM

degree/s

3. Note that as you select constituents of the supercomponent, on the left side
the two upper lists on the right are unchanged but the lowest list changes.

4. Do a Parameter mode and Run mode preview and note how messy it is! In
particular notice how prefixes, composed from the submodel name and in-
stance number, are added to some parameter/variable titles in order to make
them unique.

Figure 3.39: Parameter and variable titles

EA00-1: value of gain E null
IMTO-1: walue of gain 1 rull
offzet to be added to input 0l
rnirimunn output value 0 rull
rnawimum ouput value 360 null
GA00-2: value of gain 0,007 null
FA00-3: value of gain 0.007 rull
GAOD-4: value of gain 180/pi null

Normally it is confusing to see these prefixes in a Change Parameters or
Variable list dialog box. They can be removed in 2 ways:

* By hiding the parameter or variable so that it does not appear
anymore.

* By changing the title. If you do this, it becomes your responsibility
to ensure parameters and variables have unique titles.
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Step 2: The central list is what will become the external variables of the
customized supercomponent. Alter the titles as shown below:

Figure 3.40: Alter the titles of external variables

External wariables:

Fort I Title I Urut I Type
1 total torque port 3 MWm one-line macro variable
1 welocity at port 3 revdming wanable

External wariables:

F'UrtI Title I Lnit I Type
1 camtorque Hm one-line macro variable
1  rotary velocity of cam  rev/min - warable

Step 3: Select the root of the supercomponent tree and right-click
selecting Hide all

Figure 3.41: Hide all in the supercomponent tree

—Supercomponent

Submodel | =
B0 5 E 1 5 LUPE R M
Ll FTOAO Hide all
Fraln Show 4l
Ga0o
GAOD L:a Copy parameters
gigg l"' Baste parameters

T

You can achieve the same thing using the right-click pulldown menu in the
Explore supercomponent dialog box.

Figure 3.42: Hide all using the Explore supercomponent dialog box

|+ = ;

Component vanables and parameters

Exad

Bird's eye wiew Copy parameters

|
|
Labels » Show all |
|
|

i | L?J Pazte parameters

If you look at the Parameter and Run mode previews, you will see a dramatic
change! We must reintroduce a few variables and parameters that have been
hidden.
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Figure 3.43: Some variables and parameters are hidden

Parameters

Title |walue [Urit |

— Wariables
Title [vatue [urit |
velocity at port 3 rull iz
dizplacement port 3 null m
force at port 3 null M
output torque port 3 rull Mm
input angular velocity at port 3 rull rewdmin

Below are summarized three very important points:

1.

It is very common practice to begin by hiding ALL parameters and vari-
ables then progressively reintroducing those that are needed.

After making any significant change, it is essential to do a Parameter and
Run mode preview. This helps you to identify mistakes at an early stage.

You can change titles of parameters and variables to make them more
meaningful and to remove unwanted prefixes. If you do this, it becomes
your responsibility to ensure the titles are unique.

Step 4: Select the integrator submodel INT0, then select the Internal

variables tab and alter them as follows:

Figure 3.44: Alter the Internal variables

Internal ikems:

Internal wariables IHgaI parameters | Integer parameters | Tegt pararneters I

Title | Uit I Tope I Minimuml Defaultl MaHimuml Hidder
INTO-1: output from integrator null explicit st -1e+030 0 le+030
Internal items:

Internal variables | Real parameters | Integer parameters | Text parameters I

Title

I LUnit I Type I Minimuml Defaultl Ma:-:imuml Hidder I

angular displacement of cam in degree.  null  explicit state vari...  -1e+030 0 fe+030

Note the Hidden flag for the variable has been changed, now it is unticked.

Step 5: In a similar way make the following changes. In each case ensure

the Hidden check box is not ticked.
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Submodel Tab Original title New title if different
selected
Internal output angular displacement
MODO00 | variables of cam modulo 360 in
degree
FXA010 Integer dlscoptlnulty
parameters | handling
Text name of ASCII file | file of cam position
FXA010 | parameters function of angular
displacement

Do a preview of parameters (Figure 3.45) and variables (Figure 3.46) to check
they are satisfactory.

Figure 3.45: Preview of parameters

~Parameters
Title [ value [ unit |
# angular dizplacement of cam in deagree Ol
dizcontinuity handling inactive
file of cam position function of angular displacement FaME Autorial/datalcam. data

Figure 3.46: Preview of variables

“Wariables

Title [ value [Unit |
velocity of cam fallower null 'z
dizplacerment of cam follower nullm

force on cam follower null M
torque an cam null M
rotary velocity of cam null rev/min
angular dizplacement of cam in degree nl fall
angular dizplacement of cam modulo 360 in degre null vl

Step 6: Save the customized supercomponent under the name
CUSTOMCAMS0.

Step 7: Use the customized supercomponent in AMESim adding to the
three existing subsystems. Check it produces the same results as
the other versions. Examine the State count dialog box to see how
certain titles are hidden.

Figure 3.47: Supercomponent used in an AMESim system

CUSTOMIZED SUPERCOMPONENT
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Conclusion

This customized supercomponent is an alternative to the submodel CAMO00.
Which alternative is better? In this case the submodel is less complex and has
less redundancy. In other cases a customized supercomponent can be a better
alternative to a huge submodel. This is probably true in the next example.

3.2 Example 2: A 2-level customized
supercomponent with global parameters

3.2.1 Introduction

Figure 3.48: Two valves operating within a cylinder head

STPO

LSTPO0A
LCONTT |l ==L CON12

Objectives:

* To construct a customized supercomponent with two levels of
customization;

* To use parameters global to the supercomponent;
* To demonstrate encryption facilities.

The system is shown in Figure 3.48 and represents two valves operating within
a cylinder head of an engine. The exercise that follows is constructed to show
features of AMECustom not to serve as instruction on how to design efficient
cylinder head valve systems!
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Note that the system is precisely the same as the second example in chapter 2.
Remember that:

* There are two camshafts running at the same speed which is defined
by PM000.

o INCAMS50 and EXCAMS50 are customized submodels. This will give
two levels of customization.

e The submodels LSTP00A induce a valve clearance when the valve
is closed.

*  MASO005 features a limit in the movement of the valves.
3.2.2 Constructing the flat system

Reload the old system and check the results against Figure 3.49. This is the
valve lift and the reference set of results we will use to check the new generic
supercomponent and its customized version.

Figure 3.49: Reconstructing the generic supercomponent

1 - MASO05-2 dizplacement park 1 [m]
2 - MAS005-1 displacement port 1 [m]
0.0150+

0.0125 B
0.01004

0.00754

0,00504

0.0025—

000002

00025 i
0 \ 0. u:\ 0.08

Exhaust Intake Compression Power

Step 1: Create a generic supercomponent including all components
except PM000.
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Figure 3.50: Create the supercomponent

INTAKE

— Supercomponent creation

lzon; Ho icon specified Select an icon |

Marne: I

Brief descnphion: I

Full dezcription |
Save |

Paste Frrintt... | I Supercomponent Close |

There is no very suitable standard AMESim icon for this supercomponent. If
you are very short of time you can use any icon of the Mechanical category

which has a single rotary port such as the following one:

MTh =

However, for a more artistic solution we suggest you do the following:

L.
2.

Click on Select an icon.

You should select a category for which you have write permission. If you
do not have one, you must create it by clicking on the New Category button.

Click on New Comp Icon.

="}

Click on the Load icon file = button of the Icon designer dialog box.

There is an existing icon in a folder of the AMESim system area. Enter the
following name:

SAME/tutorial/Icons/twinvalves.xbm
or
%AME%\tutorial\lcons\twinvalves.xbm

The icon should now be loaded into the Icon designer. Define a rotary port,
an icon name and a brief description.
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Figure 3.51: Draw the icon

i Icon designer
O=E il EI ¥ 1 Zoom (%) [400 = |width: |66 X Height: | = |
lcon preview:
72BN
O
A &
| |@
Llrshal = _
Forts on icon:
t § BE 7 rshat
-
™ ‘“white Femove port
bwir walves in a cylinder head
lcon namme: |twin'¢alves Brief icon description:
Curzor coordinate: BB, 7 Cancel |
A

Step 2: Save the icon.

Make sure you do this in AMESim format E

Step 3: Select the icon you have just created from the tree structure of the
Icon selection dialog box.

1. Give a name the generic supercomponent (e.g. VALVES50),
2. Give it a brief description,
3. Save it.

Figure 3.52: Give a name and brief description

— Supercomponent creation

|can Select an iconl

Name  [wALVESSD
Brief P . n
e |twm valves in a culinder head

Full descrphion

Tl deorpn
Save |
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Step 4: Add the generic supercomponent to your AMESim system and
run a simulation to check that the results are correct (as in Figure

3.49).

Figure 3.53: Add the supercomponent to the AMESim system

. 9"@ PMOOOD|  GENERIC SUPERCGMPONENT

3.2.3 Constructing the customized supercomponent

Step 1: Load the generic supercomponent into AMECustom. Hide all
variables and parameters.

Step 2: The original external variable names shown in Figure 3.54 have
very inappropriate names. Change them to those indicated.

Figure 3.54: Alter the external variable names

External wariables:

Part | Title

| it

[ Type

1 wvelocity at port 3

1 total torque port 3 Mm
rev/min wariable

one-line macra variable

External vanables:

F'u:urtl Title | Lnit | Type

1 camtorque Hm one-line macro variable
1 rotay velocity of cam  rew/min warniable

For the time being, only external variables of the supercomponent are visible.
We must decide on what else is to be visible. There are many pairs of
submodels in this supercomponent. In order to demonstrate the use of global
parameters, we will assign the same values to many parameters from the intake
side and from the exhaust side. This symmetry is of course not necessary and
may not be desirable from a design point of view, but this is not the point of the

exercise.

It would be convenient to have the following parameters to set in AMESim:

* valve spring preload

* valve spring stiffness

* valve clearance

e valve mass

*  maximum possible valve lift
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We set these parameters once and they are applied to both the intake and the
exhaust side. To do this we introduce customized supercomponent global
parameters in AMECustom. These are like global parameters in AMESim
but their scope is solely the customized supercomponent.

The table below shows the global parameters we will use and an indication of
where they will be used. They are all Real parameters but we could also use
Integer and Text parameters.

Global type : . Min./Default/ Submodel,
Title [units] parameter/variable
and name Max. .
and title
valve spring 200/300/800 SPR000A, real
Real reload [N] arameter, free
VPRELOAD | P P -
length of spring
valve spring 1.0e4/1.0e5/ SPR0O00A, variable,
Real VSTIFF stiffness [N/m] | 1.0e6 spring rate
valve 0.05/0.1/0.2 LSTPO0A, variable,
Real clearance gap or clearance with
VCLEAR [mm] both displacements
Zero
Real VMASS valve mass 0.005/0.01/ MASO005, real
[kg] 0.05 parameter, mass
maximum 0.02/0.03/ MAS005, real
Real ible val 0.085 arameter, higher
VMAXLIFT | Possible valve . p eter, highe

lift [m]

displacement limit

Step 3: Introduce the supercomponent real global parameters shown
below. Make sure that none of them are hidden.

Figure 3.55: Alter the external variable names

Supercomponent alobal parameters:

FReal I Integer I Text |

Name | Tile [ urit | Mirimu Default +f Masimum +| Hidd
WPRELOAD walve spring preload M 200 300 gool
WSTIFF valve spring stiffness M 1.0ed 1.0e5 1.0e6
WCLEAR valve clearance m 05e-4  1.0e4 20e-4
WSS walve mass kg 0.005 0.m 0.os-
WhAHLIFT  masimum pozsible valve it m noz 0.03 n.asl

Note that you click on the Add new button to introduce each new real

parameter.
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Step 4: Use the VPRELOAD and VSTIFF global variables in both
SPRO00A spring submodels Real parameters as shown below.

Figure 3.56: Global variables

Internal ikems:
Internal waniables | Fleal parameters | Integer parameters I Text parameters I
Title I Uit I Minimum‘l Drefault vaIuEI Mauimumi Hidden
SPRO00-T: spring rate Mém I WETIFF  1e+008 [
SPRO004-1: spring force with both displacements zemm N e+006 WPRELOAD  1e+00E

Note that you can copy/paste from one spring to the other using the tree
structure.

Figure 3.57: Copy/paste using the tree structure

FLLCCE L e = )« gy —

m Hide all

- zpring0]
ping Show all

- zeroforcesc
- zeroforcesc Copy paran
- zerospeeds Faste parameters T - | | :
- Zer0spesd s T [ [PRO00AT] - SNNg Internal jtems:
gl Hide all o
- zeroforcesource
Show all
- zerofolcesource
... zerospeedsounc: Copy parameters [ o
- ZEM0zpeadsounc: - .
1 b A=k,

You can do the same thing in the Explore Supercomponent window.

Figure 3.58: Copy/paste using the Explore Supercomponent window

Cormpaonent variables and parameters Hide all

External variables Show all

Labels Copy param
Bird's eye view Fazte parameters
Help | |

Hide all
Esternal wariables Show all
Labels 3 Copy parameters

Bird's eye view

Help

A third technique is to select both springs in the tree structure or both springs
in the Explore supercomponent window. This works like Common Parameters
in AMESim and you can set the values for both springs simultaneously.
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Figure 3.59: spring values can be set simultaneously

Step 5: Using the same techniques set the VCLEAR global parameter in
both LSTP00A submodels as indicated.

Figure 3.60: VCLEAR global parameter

Intemnal items:

Internal wariables Real parameters |nbeger parameters I Text parameters I

Title I Uit I Minimum\l Default '\.-'4 M awinum w{ Hig
LSTPOOA-1: gap or clearance with both dizplacementz zemn mm 0001 WCLEAR 1000
LSTPOOA-1: contact stiffre MAm 1e-020  Je+009 1e+0300
Step 6: For both MAS005 submodels make the modifications shown
below.
Figure 3.61: Modifications for both MAS005
Intemal items:
Internal variables Real parameters Integer parameters | Teut parameters |
Title | L rit I Mitirnum \I Drefault '-r'a|lI I axirnurn \-'I Hid
MAS005-1: mass ka 1e-008 WhASS 1e+006[¥
1A5005-1: coefficient of viscous friction M my's] 0 ] 10000
MAS005-1: coefficient of windage Mtz 2 0 I} 1000w
kA5 005-1: Coulomb Friction force M 0 il 10000
MA5005-1: stiction force M 0 il 10000
1AS005-1: lower dizplacement limit m 1e+030 a 1e+0300
tAS005-1: bugher displacement limit m 1e+030 WhaLIFT 1e+030[%
FMASO05-1: inclination [+30 port 1 lowest, -90 port 1 highest] degree -80 i = v
Step 7: In the inlet MAS005 submodel alter the Internal variables as
shown. Make the corresponding changes in the exhaust side.
Figure 3.62: Alter the Internal variables of MAS005
Internal iterns:
Internal wariables | Real parameters | Integer parameters I Test parameters I
Title | it | Typs | Minimuml Defaultl Maﬁimuml Hid
MASO05-1: activity of mechanical dissipation [frict] J activity variable rd
MASO05-1: activity of mechanical inertia [maszs) J activity variable v
inlet walve velocity mfs  explict state vanable 1] 0 or-
inlet walve lift m ewplicit state variable 0 0 or-
inlet walve acceleration mesds  vanable r
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3 (x2) Internal variables have had their titles altered and are not
hidden anymore.

2 (x2) Internal variables have their minimum, maximum and
default values set to 0. This makes them invisible in Parameter
mode but as they are no longer hidden, you will see them with
their new titles in Run mode.

Step 8: In the inlet cam INCAMS50 submodel alter the second Internal
variable as shown. Do not change the exhaust side.

Figure 3.63: Uncheck the Hidden box for the second variable

Internal iterns:
Internal vaniables | Real parameters I Integer parameters | Test parameters |
Title it | Type | Mirim| Defa] Maim] Hid
IMCaRB0-1: angular dizplacement of the cam degree  explicit st 0 1] =
angular positions of cams degree  mult-ling ... r
IMCAMB0-1: transformer ratio m multi-ling ... g
welocity of the inlet cam follower més one-line ... v
dizplacement of the inlet cam follmer m mulb-line .. ¥
tarque an inlet cam M one-line ... =
Note: «  We have forced both cams to have a starting angle of 0. We will

not be able to change this.

We have forced the starting value of the gap or clearance in both
LSTP00A submodels to be VCLEAR.

With both cam profiles starting on a flat part the starting values
of various state variables are consistent.

Step 9: Do a Parameter mode preview (Figure 3.64) and a Run mode
preview (Figure 3.65).
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Figure 3.64: Parameter mode preview
" AMESim Parameter Mode Preview ed b

—Submodel

UNNAMED_VALVESS50-1

=1
&1 Extemal variablesl

twith valves in a cplinder head

—Parameters
Title: |value |unit |
valve spring preload 3000
walve spring stiffness 100000 M fm
walve clearance 0.0007
valve mass 0.07 kg
maximum pozsible walve lift 0.03m

Help | Optiotig »» |
Figure 3.65: Run mode preview
i AMESim Run Mode Preview x|
— Submodel
3 UNHNAMED_VALVESS0-1
.,/ . . External variablesl
bwin walves in g
cylinder head
—Wariables
Title |vale |Urt |
Cam torgque null Mm
rotary velocity of cam nul res/min
angular positions of cams null degree
inlet valve velocity null m/ds
inlet valve lift null m
inlet valve acceleration null mdzds
exhaust valve velocity null s
exbaust valve it null m
exhauzt valve acceleration null mdzdz

Help |

Step 10:Save the customized supercomponent as CUSVALVES50. This
time specify a password, but do not forget it!

Step 11:Add the customized supercomponent to your AMESim sketch
and check that it produces the same results.
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Figure 3.66: Add the customized supercomponent to the sketch

CLUSVALVESSD

CUSTOMIZED SUPERCOMPONENT

We hope that you find using CUSVALVES50 within AMESim more pleasant
than the generic equivalent.

Step 12:Use the state count facility and also examine in an editor the .state
and .var files produced by AMESim.

The important thing to realize is that things hidden by AMECustom appear
under very unhelpful names (Figure 3.67). This is true even if it is not
encrypted. In AMECustom you define what is private and what is public.
AMESim only shows the public part.

Figure 3.67: State count dialog box

Summary of which state varisbles controlled the integration step size:

State Mo | Controlled | Submadel | varitle [urit |
1 x| hiciden wariable
2 a hiclden variable
3 FIT24 CUSWVALYWESSO-1 inlet valve velocity mis
4 u} CUSVALYVESSO-1 inlet walve lift m
H S34EE CUSWVALWESSN-1 exhaust valve velocity mis
G 1 CUSWALYESS0-1 exhaust valve lift m
Time: 0.1 =

[~ Automatic update

Cloze |

&

3.2.4 Activity variables and customized
supercomponents

Following the steps in the previous section the status of all activity variable are
hidden. For this reason you will not have access to these variables in AMESIim
regardless of the state of the Activity index calculations check box in the Run
Parameters dialog box.
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We will now reintroduce these activity variables.

1.

In AMECustom uncheck the hidden box for all activity variables. You
will then get the following Run mode preview.

Figure 3.68: Run mode preview

—ariables
Title [vae |urit |
cam torque rall Fm
ratany velociby of cam Al e i
angular position of cams rull degree
LSTPO0A-T: activity of mechanical dissipation [damp] rdllJ
LSTPOQA-T: activity of mechanical capacitance [spring] rwallJ
LSTPOQA-Z: activity of mechanical diszipation [damp] rll
LSTPO0A-2: activity of mechanical capacitance [zpring] rdllJ
inlet walve velocity rall s
inlet walve lift rall m
inlet walve acceleration rall s s
MASO05-1: activity af mechanical dizzipation [frict] rdllJ
MASO05-1: activity of mechanical inertia [mass) rwdll
SPRO00&-1: activity of mechanical capacitance [zprng) rudll]
SPRO0OA-2 activity of mechanical capacitance [zpring) rll
exhaust valve velocity rdll o'z
exhaust valve lift rall m
exhaust valve acceleration rall midzds
MASODE-2: activity of mechanical dizsipation [frict] rllJ
MASODS-2: activity of mechanical inertia [mass) rdllJ

Actually since there is no friction in the MAS005 submodels and no possi-
bility of adding friction in AMESim, these two particular activities will al-
ways be zero and hence can be hidden.

Take each activity variable in turn and remove the unwanted prefix and ad-
just the titles to make them unique. Below are some suggestions.
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Figure 3.69: You can remove unwanted prefixes
—Waniables

Title |value | Urit
carm targue null Mm
rotary velocity of cam null rev ik
angular position of cams null degree
activity of mechanical dizgipation [inlet congtact damping] nlld
activity of mechanical capacitance [inlet contact zpring) nulld
activity of mechanical dissipation [exhaust contact damping) nulld
activity of mechanical capacitance [exhaust contact spring) nullJ
inlet walve velocity null iz
inlet walve lift nll m
inlet walve acceleration rllm/s/s
activity of mechanical inertia [inlet mazs] rull]
activity of mechanical capacitance [inlet valve zpring] nlld
activity of mechanical capacitance [exhaust vakve zpring) nulld
exhaust valve velocity null m/s
exhaust valve lift null m
exhaust valve acceleration nllm/seds
activity of mechanical inertia [exhaust mass] nulld

3. Save the customized supercomponent and load the revised version into

AMESim.

4. Enable Activity index calculations and do a run.

v Activity index calculations

Use Tools P> Activity index to produce an Activity Index List dialog box.

Figure 3.70: Activity Index List dialog box

Submodel | Title: | Walue I Uit I Type | Index | %

CUSYALWESS0-1 activity of mechanical dizsipstion (exhaust contact damping) 1.966e-004 J
CUSWALYESS0-1 activity of mechanical dissipstion (inlet constact damping) 3.862e-004 J
CUSWALWESSD-1 activity of mechanical capacitance (inlet contact spring 27 e-002J
CUSYALWESS0-1 activity of mechanical capacitance (exhaust contact spring)  3.007e-002

CUSYALWESS0-1 activity of mechanical inettia (inlet mass) 1.059e+000J
CUSYALWESS0-1 activity of mechanical inertia (exhaust mass) 1.444e+000J
CUSYALNVESSD-1 activity of mechanical capacitance (inlet valve spring) E.474e+001 J

CUSWALWESSD-1 activity of mechanical capacitance (exhaust valve spring) B.6762+001 J

R

O o— — O (0 3

1.467e-004 %
2.855e-004 %
2.052e-002 %
2.243e-002 %
7.896e-001 %
1.077e+000 %
4.529e+001 %
4.930e+001 %

3.3 Conclusion

You should now have some idea of what AMECustom does. At this point it
is appropriate to reread section 1.5 where ideas on how AMECustom can be

used are presented.
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Chapter 4: Reference Guide for AMECustom

4.1 Introduction

This guide is designed to be used for reference from the main index. It is
organized as follows:

* adescription of The AMECustom main window,

» features available from The AMECustom menu bar,

» features available from The AMECustom Toolbar,

» categories available from The Category buttons,

» adescription of The customized object general features,
» apresentation of The global parameter lists,

» apresentation of The External variables list,

» apresentation of The Internal items lists.

4.2 The AMECustom main window

The empty main window of AMECustom is shown in Figure 4.71. Click on
the menu bar or move your mouse pointer on the toolbar and the category
buttons to have more details:
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Figure 4.71: AMECustom display

EAMEEuslum _ O] %]

Menu
bar

=
H[i H L | Toolbar

File Edit Options Previews lcons Tool: Documentation Windows Help  <€+4—

Main
I Window

|
Category
buttons

When an object is loaded, the main window looks like in Figure 4.72.

Figure 4.72: Main window with a submodel loaded

— External items

| CUSTOMCAMED

Supercomponent alobal parameters:

Real Ilnteger Ile:-:t | 1 | 'l |
2;@3:“ cam? M arne |Tit|e |Unit |Minimum | dd rew Global

| parameter

4 I I _PI Hemn\.-e | lists

Change icon | Euternal variables:

Erief description: Port | Title | Lt | Type il
|generic supercomponent cam 1 welocity of cam follower miz  oneline

External
variable

1 dizplacement of cam fallower m oneline '+ .
o list
Full dezcription 4 | | »

— Supercomponent

Intemal items:
Submodel | Type =~
-+ CUSTOMCAMSD super Internal variables I Real parameters | Intege 4| »
;00 conp Title Unit | Type
_| A m:ﬁILI f — |N | PDI_ - Internal
4 | | b arce at por one-ine macra vari, .
. . - item
FTO10-1: signal autput rnull one-line macra wan X
Explore | lists
| | 2+

Customized object
general features
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This nomenclature will be used throughout this chapter.

Note: If a customized submodel is loaded rather than a customized super-
component, the customized object general feature area is simpler
than the one shown in Figure 4.72.

4.3 The AMECustom menu bar

Each menu allows you to access the main AMECustom commands. See the
details in the following sections:

¢ Icons menu

* Documentation menu
4.3.1 File menu

Figure 4.73: File menu

File Edit Options Previews lcon: Tools Documentation windows

E Open... Cirl+0
& Save Crl+5
Save az..

1: D:/ModelsFort anual/submodels N CAMBD. spe

21 D ModelsForkd anual/submodelz Y ALVE SO spe

3 D:/ModelsForkd anual/zubmodels/ACUS T OMCAMET 2pe
4. P:/AME SimAvd. 2. 0/submodele MCLCOAA zpe

Close

Cluit Clrl+Q)

Open

“u
V=2
This method allows you to select generic or customized objects by name
rather than by icon.

To open an object you can also:
» click on the button in the Toolbar,
* use the Ctrl+O shortcut.

If you select Open in the File menu, you will get a file browser to enable you
to look for .spe files. Hence you should normally search in the submodels
folder of AMESim nodes.
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Save

Save as
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Figure 4.74: File browser in the Open dialog box

Open EHE

Look jn: |_\4AMEEustnm LI | I'j‘l |
Edemos:

| licons

|__Isubmodels

Files of type: [ Submodel specification files [*.spe) | Carcel |

You can open .spe files of:
* generic submodels,
* generic supercomponents,
* customized submodels,
* customized supercomponents.

Any object selected that can be read will be loaded into the AMECustom
main window.

Note that all successful save operations in AMECustom will always produce
customized objects.

Select this menu item when you think your customization is complete and you
want to save it. If the customized object is new, Save behaves like Save as.

=
You can also click on the Save button in the Toolbar or use the Ctrl+S
shortcut.

Select this menu item when you want to save a customized object under a new
name and/or in a different AMESim node. You must specify the name and also
the AMESim node (Figure 4.75).
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Figure 4.75: Save as process

P Enter Mame and Password Browse for Folder EHE

Subrnodel name: Select a directary

[CUSTOMCAM Ci\AMETest
[~ Save encrypted E|_) AMETest ;l
-{2) demas
Pagzword {3 Icons
Enter password; i submodels
[H-1T) SuperTest
I ..... J DELL
Confirm passwarnd: [+-{7) Docurments and Settings
[#-Z) Program Files
| (-5 WINDOWS
----- ) ws_FTP _lll
Ok Cancel | | v

QK I Cancel |

Note: You can save a customized object encrypted. If you do this, you will
have to set a password. Encrypted objects cannot be opened in
AME Custom without their password.

Last opened files list

This section of the menu displays the last opened submodels or
supercomponents.

You can change the number of the last opened files to display by using Options
» AMECustom Preferences...

Close
Select this item when you wish to clear the active submodel or
supercomponent.
If AMECustom thinks it has changed, you will be invited to save it.
Quit

Select this item when you wish to leave AMECustom. If loaded objects have
changed, you will be invited to save them.

You can use the Ctrl+Q shortcut.
4.3.2 Edit menu
The first eight items only operate on a selected global parameter.
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Figure 4.76: Edit menu

Edit Options Previews lcons Tools Docum
& Cut Tl
= Copy Ctrl+C

Paste 3

Delete Del
Add new Ins

Trash Can... »

M ove up Chil+Up

== 0 X F

Move down Ctil+Down
Hide all
Show all

Update categonies

External variables. ..

Awailable customized...

Awailable supercomponents...

Anailable uzer submodels...

Cut
.:H: The selected global parameter is removed. The shortcut is Ctrl+X. The
facility is also available by clicking on the Cut global parameter button
in the toolbar.
Copy
B The selected global parameter is copied into a special buffer or
clipboard. The shortcut is Ctrl+C. The facility is also available by
clicking on the Copy current item button in the toolbar.
Paste
The contents of the selected global parameter are overwritten with the
=l contents of the clipboard. The shortcut is Ctrl+V. The facility is also
available by clicking on the Paste current item button in the toolbar.
Delete
The selected global parameter is deleted. The shortcut is Del.
Add new
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A new global parameter is appended at the end of the list. The shortcut is Ins.
Trash can

= This opens a dialog box from which the latest global parameters that

LT have been deleted are shown:

i} Trash Can

Real params Ilnt. paranmns I Text params |

Source submodel

ance 00001
walve mass kg WhASS 0.0

Mb elements; 2 Restore | Erpty Trash Canl

Z

It is then possible to restore some of these or to empty the trash can. The
shortcut is Ctrl+T.

Move up
If it is possible, the selected global parameter is moved up one position in the
list. The shortcut is Ctrl+Up.

Move down
If it is possible, the selected global parameter is moved down one position in
the list. The shortcut is Ctrl+Down.

Hide all
This option hides all internal items of the customized object currently selected:
a tick mark appears in every check box of the Hidden column.

Show all

This option shows all the internal items of the customized object currently
selected: all the tick marks in the check boxes of the Hidden column are
removed when possible.

Update categories

This option updates the categories and their contents according to the current
path list.
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External variables

This option produces a dialog box showing the external variables associated
with each port of the selected customized object.

Figure 4.77: External Variables window

INCAMS0

inlet cam and cam follower

For vanshize which bave & Sigction ssociaieg with them =
Lotz sign e i e Siction of the SmoW.

—H =+ mz
m

L)
= 1evTin :l_ -

Available customized

This option produces the list of available customized objects (submodels or
supercomponents) from the current path list. You can select from this list and
load into AMECustom for editing (click on Load) or deleting (click on
Remove) any existing customized object.

Figure 4.78: Available Customized Submodels dialog box

E Available Customized Submodels EHE
M ame | Type | lcon * Load |

E| D:/AMETest/tutorial/submodels  Storage directomy

E| cama Component ican 5@31

CUSTOMCAMEBD Custamized component
: - IMCAMEBD Custamized component
e EXCAMED Cuztomized component j Hemaove

Available supercomponents

This option produces the list of both generic and customized supercomponents
that are available from the current path list. You can select from this list and
load into AMESim (click on Load) or load into AMECustom (click on
Customize) or remove (click on Remove) any existing supercomponent.
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Figure 4.79: Available Supercomponents dialog box

E Available Supercomponents

=

Load

M armne I Type | lcon
[ rotargload2 Component icon w
- btz amn Component icon i&)‘i&
= pump3 Component icon ﬁ
L=t =a Supercomponent
<

Customize

ik

]

Bemave

LCloge

i

Available user submodels

This option produces a list of both generic and customized submodels that are
available from the current path list. This list is limited to user submodels only.
This means submodels that do not belong to any standard AMESim library.

You can select from this list and load into AMESim (click on Load) or load
into AMECustom (click on Customize) or remove (click on Remove) any

existing user submodel.

Figure 4.80: Available User Submodels dialog box

F available User Submodels

Marne | Type | lcon |

- T A8ME Test/submodels  Storage directom

Component icon

Campanent icon

E| pricyverdl

e PMED

elasticendstop

=l

Load |
_ Custonize_|

Cugtomize

Bemaove |

Cloze

4.3.3 Options menu

Figure 4.81: Options menu

Optichs  Previews Tools Windg
Path lizt

LColor preferences

AME Cuztom Preferences
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Path list
Select this item to change the AMESim path list. This functionality is precisely
the same as in AMESim.
Figure 4.82: Path list dialog box
Flpath List EHE

The path is used for finding AME . make, AMElcons, submodels.index.
You can either pick the libraries on the right or add a directon using
the text field and browse button below.

Fath ligt zhould contain at least "$AME' path,

— Current path list —Available categones

famE Standard AkE Sim library ﬂ
ll Hydraulic: [$aME Aibkwdr)
Hudraulic Compaonent 0 esign [$AME /i
Hydraulic Resistance [$AME Alibhr) -
I | >
3|5

Remove | Browse . | Add o path list

L

—&dd user defined path
Add | |

v Update categories

Color preferences

Select this item to change colors assigned to categories and lines as well as line
styles. This functionality is precisely the same as in AMESim.

Figure 4.83: Color preferences dialog box

FElcolor Preferences

—Categories

Description: Color:

IMechanicaI LI !l Default |
—Lines

Tope: Style: Color:

ISignaI LI |— - — LI !l Default |

LCancel |
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AMECustom Preferences

Select this item to produce the AMECustom Preferences dialog box. Figure
4.84 shows the options set to their default values.

Figure 4.84: AMECustom Preferences dialog box

E AMECustom Preferences
¥ Preview in file browsers Application fontl

Mumber of filez in 'Lazt Opened Files' list: 4 =

HTHL & equation editor: I J

—Check Submodels

Create backup after check: & askme always never

—Background

= Colar: !l
£ |mage: | J

Bestore $tandard| Apply LCancel |

The Preview in file browsers check box applies to the Background area when
the /mage button is selected and the browse button is clicked.

If you click on Application font, you can select a different default font for
AMECustom.

Number of files in ‘Last Opened Files’ list allows you to change the number of
files displayed in the Files menu.

You can select the HTML editor you wish to use from AMECustom in order
to complete or modify the documentation associated with your customized ob-
jects.

After a check submodels is applied to a customized supercomponent you have
the possibility to create a backup of its original version. You can choose this
backup is created always, never or on demand.

The two radio buttons under the label Background allow you to change the
default main window when no objects are loaded. If Color is checked, you can
select a particular color. If /mage is checked, you can enter the path and name
of a file to specify an image to be used. Alternatively you can browse for the
file and if the Preview in file browsers check box is ticked, you will see a
reduced size image of the selected file in the browser.
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4.3.4 Previews menu

Figure 4.85: Previews menu

Ereviews Tools Wwindows Hel

'%..q Parameter mode

@ Bun maode

Parameter mode

é\\—p This option takes the active object in its current state and shows how the
Change Parameters dialog box will look like for this object in
AMESim. You can also click on the button in the 7oolbar.

Use this facility frequently when you are customizing submodels and
supercomponents as you can identify mistakes at an early stage.

Run mode

This option takes the active object in its current state and shows how the
Variable List dialog box will look like for this object in AMESim. You
can also click on the button in the 7oolbar.

Use this facility frequently when you are customizing submodels and
supercomponents so that you can identify mistakes at an early stage.

4.3.5 Icons menu

Figure 4.86: Icons menu

lcong Tool: Documentation
Add categony...
Bemove cateqam.
Add component....

Femove compaonent...

lzon designer..

LChange abject icon...

Add category

If you do not want to use a component icon from the available AMESim
libraries, you must create your own component icons and these must be stored
in your own category icon. Category icons are the ones you see at the left side
of the AMECustom window.

The steps involved in creating a new category icon are the following:

1. Select Icons > Add category...
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A browser appears.
2. Select a directory for your category.

Figure 4.87: Browsing for a Folder for an AMESim category.

Browse for Folder EHE

Select a directory for the new categary

+-=0 3% Floppy [&:]
H-i=3 System [C:]
H-i=n Data D]
02 (E:)

E
£
£
[
#-52 Home_Prod on 'Fatsnake' [H:)
£
£
£

+- 52 Appli on 'Fatsnake' [F:)
+- 52 Public on Fatsnake' [Z]

-8 web -

] | Cancel |

3. Click on OK.

If the selected directory is not in the AMECustom path list, the following
dialog box is produced:

Figure 4.88: Adjusting the Path List.

P& Mot In Path List []

\q]) Thiz directary iz not in the path izt Do yow want bo add it?
L]

You can then update your path list and you will be asked for the category
name and description. As soon as the description is validated, the /con
Designer appears. You can now create an icon for the new category.
Remove category
To be able to remove a category
+ there must be no component icons in this category and

* you must have write permission for the appropriate .xbm, .ico and
AMEIcons files.

1. Select Icons P> Remove category...

The Remove Category dialog box appears:
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4.

Figure 4.89: Removing a Category.

FEiRemove Category EHE
Select the category you want to remove:
I Mechatical j

[~ Remove icons files [*ico, *.xbm]

Cancel |

&

Select the category you want to remove.

Check the box Remove icons files if you want to remove also the files of the
icon (.ico, .xbm).

Click on OK.

Add component

Step 1: Create a new component

L.

2.

Select the Add component item of the Icons menu.

The dialog box shown below is displayed:

Figure 4.90: Adding a New Component Icon.

H Design Component Icon EHE

Draw icon |
lcam: Ho icon specihed Load bitmap |

Select icon |
Marme: |
Drezcription: |
Farent categony: I Hydraulic, pneumatic and electical ines j
LCancel |

Fill in the Name, Description and Parent category fields to give the neces-
sary information on your new icon.

Step 2: Specify an icon for the new component.

There are 3 different ways of assigning an icon:

Draw a new icon: Click on the Draw icon button to produce the Icon
Designer. Design the icon and set its ports: please refer to the AMESim
manual section 6.5.2.Creating a supercomponent icon (step 1 to step 6) to
learn how to create an icon and add ports to it. Finally click on the Save icon
to AMESim files button of the Icon Designer dialog box.
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* Load a bitmap from a file: A file browser allows you to load a bitmap
from a file.

* Select an existing icon from another category: Select the icon you want
within a list of existing icons.

When you have designed the icon and set its fields properly, click on the OK
button.

Remove component
To be able to remove a component icon:

* there must be no submodel or supercomponent associated with the
icon and

* you must have write permission for the associated .ico file.
1. Select Icons P> Remove component...

The Remove Icon dialog box appears.

Figure 4.1: Removing a Component Icons.

FElRemove Icon EHE

Select the component icon you want to remove:

lcon: I Select |

Farent categony: I Mechanical j

LCancel |

&

2. Select the component icon you want to remove using the Select button.

3. Select the parent category of the component icon.

4. Click on OK.

Icon designer

The Icon designer facility can be started as a general facility if you select Icons
P Icon designer... It can also be started when creating a new category icon or
when creating an icon for a customized object.

With the AMECustom Icon Designer, you can create and save one or more
icons and specify their ports. Please refer to the AMESim manual section
6.5.2.Creating a supercomponent icon (step 1 to step 6) to learn how to achieve
this.
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Change object icon

Use Icons > Change object icon... if you want to

replace the existing icon which the current active :@}}
22 1 camZ2

customized object is associated with. You can do the
same thing by clicking on the Change icon button. In

either case an Icon selection dialog box is created. Change icon |

Figure 4.2: The Icon selection dialog box

E Icon Selection EE

MHame

I |can

E| Mecharical i‘-{_‘%}

- 1ack2 :&‘
- Cam2 E@I&

- AT ﬂ@
- zimple_crank,

QK. Cancel

Expand the tree structure and select the new icon.

Note that you will be presented with subset of icons. These are the ones that are
compatible with the active customized object. It is possible that no icons are
suitable! In this case you will have to create one. Naturally you must create
your new icon before you can attach a customized object to it.

4.3.6 Tools menu
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Toolz Documentation  windoy
AMELexicon... Chel+L
Check. submodels...

Expression Editor. ..

Start AME Sim...
Start AMESet. ..

License viewer...

The items on this menu are a reduced set of those
available in AMESim. The Check submodels item
needs further explanation in the special context of
AMECustom.
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You can use AMELexicon at any time while working with AMECustom. The
main function of the AMFELexicon utility is to help you to make the titles of the
parameters and variables consistent. When you create your own customized
objects, it is extremely easy to have titles that almost the same as the titles in
other related generic or customized objects. Unfortunately ‘almost’ is not good
enough for facilities like Common Parameters!

Basic rules

When you select a library in the path list within the Build tab, AMELexicon
scans the submodels of this library.

You have the option to restrict the search by filtering according to
submodel name, variable/parameter title and unit.

Results of a search are shown under the Titles tab.

In the Titles tab you have a Variable titles and a Submodels list. The
Submodels list displays the submodels with titles with in the Variable titles.

AMELexicon recognizes the difference between variables/parameters with
identical titles but different units

You can drag and drop the title you want onto a variable/pa-
rameter in you active AMECustom object.

If you double-click on a submodel in the Submodel lists, AMECustom
attempts to open AMESet with the submodel loaded.

If a title seems to appear twice in the list with the same unit, this probably
means that there is a spelling mistake on one of the two titles.

AMELexicon dialog box

To produce AMELexicon dialog box, select the menu Tools » AMELexicon...

When you open the AMELexicon dialog box, the Build tab is displayed first.
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Figure 4.91: Build tab
I3 AMELexicon 21 x]
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The Build tab contains four groups of options:

Path list

This is the current AMECustom path list.

The buttons Select None and Select All are obvious.

The button Update Path List is useful if you have modified your path list and
you want to update it in this dialog box.

Submodel filter

In the white field you can enter a name of a submodel from which you want to
check the parameter and variable titles. Alternatively you can use wildcards
like * and ? to specify a collection of submodels.:

To find Do this Example
Zero or more Enter an asterisk HL*4 finds submodels
characters, excluding | (*). such as HL04 and feet.
spaces and
punctuation
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To find Do this Example
Any single character, | Enter a question F??4 finds submodels with
excluding spaces and | mark (?). four-letter names that
punctuation begin with F and end with
4--for example, FP04.

You can filter variables, parameters or both.

Title filter
You can enter one or several words in the white field.

If you tick the Case sensitive box, AMELexicon will take into account the case
of the words you typed in.

If you tick the Exact Match box, AMELexicon will take into account the exact
text string you typed otherwise it takes the words in the string as key words.
Unit filter

You can type several units in the white field separated by a space. AMELexicon
will give you the list of parameters and variables which have the same units.
Generate button

When you have entered the characteristics of the search, click on the Generate
button. This produces the Titles tab containing the title list corresponding to
your search. By selecting a particular title, the Submodel list is reconstructed to
show the submodels associated with this title.

Figure 4.92: Titles tab

K AMELexicon HE
Titles | Buid |
Wanable titles:
Ref | Title it
1 final speed i
1 prime mover zpeed .. revdmin
1 startup time 5
1 time constant g
Submodel list:
lcon | Library | Subradel I Flace
meca  hi/amesimdsubmodelz/submodel: TEST_PhS0real par
d | o

Frint Submodel Listl
Cloze |

-
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You can drag and drop a title from AMELexicon to a title of a parameter or a
variable within AMESet or AMECustom. This can be done only for titles. If

you place the cursor in the wrong place, it becomes a ®
Check submodels

In AMESIm Check Submodels is used to check the active system or generic
supercomponent. The idea is to provide a mechanism for painlessly updating
the system or supercomponent with respect to changes in the specification of
the constituents.

In AMECustom the check can be applied to the active:
* customized submodel or
* customized supercomponent

In the first case, the specification file of the customized submodel is compared
with the specification file of its generic version. This is what we call a Check
consistency.

In the second case a full Check submodels is applied as in AMESim, since a
supercomponent is just like a piece of an AMESim system.

Basic rules

The following basic rules apply to Check Submodels in AMECustom:

»  Check Submodels starts automatically when you load an object.

*  When it starts automatically and there is no problem, no dialog box appears.

*  You can also start it manually using Tools P> Check Submodels... you
should do this when you are altering a generic object or its constituents and
simultaneously its customized version is used in AMECustom.

» Ifyou start Check Submodels manually and have made changes to the
object in AMECustom, do a Save first.

Check submodels of a customized submodel

This is the simplest case, AMECustom compares the specifications of the
customized submodel with the specifications of its generic version.

+ If there are important differences (the number of ports has changed) you
should completely rebuild the customized submodel.

+ Ifthere are just differences between the titles of the variables or parameters,
AMECustom will ask you to make the link between the customized and
the generic versions:
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Figure 4.93: Check customized submodel

- Check Customized EE

Select the parameter of the generic
gubmodel comresponding to the ohe of the
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Customized submodel;

Idi&placement of the inlet carm fallowver [m]

Generic submodel:

| dizplacement of the cam follower [m] ;I

ement of the cam fol 1 [m]
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tarque on cam [Mm]

* In other cases, AMECustom will give you the possibility to update the
customized version according to the new specifications of the generic
submodel. This can happen when the unit of a parameter or variable has
changed, or when the number of parameters or variables is different:

Figure 4.94: You can update the customized version

# Consistency Check

P Some differences haz been found between generic and customized submodel specification,
iy Do you want to update the cugtomized object to fit the new generic specification?

Check submodels of a customized supercomponent

It you start the process manually, a Check Submodels dialog box is produced:

Figure 4.95: Check submodels dialog box

#i Check 'CUSVALVESS0' Submodels

Circuit version: 4.2.0 Dietails > |
AMESim version: 4.2.0 —

Checking: i
B e |
= Cloze

You can click on Start with the dialog box in this state or expand it by clicking
on Details: the dialog box then takes on the form shown below.
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Figure 4.96: Check submodels extanded dialog box

i Check 'CUSVALVESS0' Submodels

Circuit version: 4.2.0 Detai
AMESim versior: 4.2.0 I i

Checking:
= e |
= Cloze

Subrnodels Iﬂepurt |

Submodel | Check | Update | Type | Accesz Path |
-4 Circuit circuit

| |

[~ Use this path far other subrmodels

[v Tiytouse zame path as in circuit

[arcre Update [~ Update all

Note the Try to use same path as in circuit check box. By default this is enabled.
Normally we expect supercomponent constituents not to have moved and so
you do not need to change the default. However, if you move a
supercomponent from one computer system to another, the paths used in the
supercomponent file is likely to become irrelevant and hence you should
disable this check box.

Note also the tabs labeled Submodels (selected by default) and Report. The first
show the tree structure of the supercomponent circuit as the check proceeds and
the second is more detailed and contains no graphics. It is of a form that can be
printed.

Submodel location

AMECustom checks the constituents of the loaded supercomponent against
their specification. This involves finding the constituent .spe files (and .sub
files if appropriate). It locates these from the specification of the loaded
supercomponent, from the current AMECustom path list or, if it is
unsuccessful, it will ask for your help in locating these files.
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Note: « It is worth reviewing the current path list first and adjusting it if
necessary.

* Inmost situations the Try to use same path as in circuit check box
should be left checked. However, if the object loaded into AME-
Custom has just been moved from one computer system to an-
other, its path name may be wrong and it is more efficient if this
box is unchecked.

+ If AMECustom needs help finding a file, it will tell you the
name of the file. You can then enter the path in the input box or
use the Browse button to search for it.

» Ifyou think that this path may need to be used again, check the
Use this path for other submodels box.

Check submodels starting

Start the process by clicking on Start. A check finished message is displayed
with no report of any problem if the supercomponent is up-to-date.

However, the process will stop if a problem is found. There is an entry in the
Report window explaining the nature of the problem. Note that the procedure
is the same as for an AMESim model. For more details please refer to the
Check submodels section of the AMESim manual.

It is vitally important that after an update you examine the customized
A object very thoroughly.

Remember that it is not possible to reconstruct an egg from an omelette! For
catastrophic changes it may be better to remove the old customized object
and create a new one.

Expression Editor

Start of the Expression Editor

There are two different ways to start the Expression Editor:

* when setting a value for a parameter or variable, click on _I to display the
Expression Editor,

* use the menu Tools > Expression Editor...
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Figure 4.97: Expression Editor
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Use of the Expression Editor

You can use the Expression Editor for:

calculation,

entering mathematical functions and expressions as a parameter value.

Procedure

1. To enter a mathematical function in the input box, select a function in the
Mathematical functions list.

2. Double-click on the mathematical function.
The mathematical function is placed in the input box.

3. Enter one or several values in the brackets.
You can select values in the Fundamental constants and Global parameters
lists by double-clicking on the values.

4. If necessary complete the expression by selecting operators and functions
in the two lists.

5. When your expression is complete, click on the equal button.

The result is displayed, when possible, in the grey box next to the equal but-
ton.
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Expressions
The expressions that you can enter in the input box can be made up of:
» global parameters;

» real and integer constants;

+ the label PI which is taken to be an approximation to 7T ;

+ the arithmetic operations +, -, *, / and for raising to a power * or **;
» the boolean operations: !, |=, &&, ||, >, <, >=, <===;

» parentheses ‘(“ and )’ with their usual mathematical significance;

* coma ‘,” for seperating variables;

+ the following functions of one variable:

sin cos tan acos asin atan log logl0
sinh cosh tanh acosh  asinh atanh  exp abs
sqrt integ differ  Isqrta  fabs

+ the following functions of two variables:
atan2  sign

+ and the following functions of two or more variables:
min max

AMESim will first check your expression. If it finds it is acceptable, it will
enter the expression as a value of a parameter if you started the Expression
Editor from the value field of a parameter or variable.

Note: The maximum size for an expression is 255 characters.

Start AMESim/Start AMESet
Just click on these items to start AMESim or AMESet.
License viewer

Select this item to see who is currently using AMESim product licenses.
Normally this is only useful for clients who have multiple licenses. Note that
you do not use a license for an AMESim library to use this library in
AMECustom. For example you can use a pneumatic library icon and make a
copy of a pneumatic library submodel for customizing without using a
pneumatic library license token.
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Figure 4.98: License Viewer displays the available features

E License Yiewer EHE

Feature uzed I Index | Max. no. | User | Machine |ﬂ
LAkE Custom 1 100 Support  refwzk
OB S et 1 100 il image10
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(AAE Simn 2 100 Suppart refil j

4.3.7 Documentation menu

Figure 4.99: Documentation menu
Documentation ‘indows Help
LCreate HTML skeleton...
Edit HTHML documentation. ..

Wiew HTML documentatior...

Create HTML skeleton

Select this item to create HTML documentation for the active customized ob-
ject.

Note: <+ The name of the file is inherited from the customized object
with an h#ml extension.

» This.Atml file is put in the doc directory of the AMESim node
in which the customized object is stored.

* The .Atml file is constructed from the specification (.spe) and
source code (.c and .f; if any) of the generic version of the
customized object. For customized submodels, fill in the full
description part of the source code as this forms a major part
of the documentation.

Edit HTML documentation

Use Documentation > Edit HTML documentation to modify and complete
the various sections of your customized object documentation. If no HTML ed-
itor is specified in the AMECustom preferences, you will be asked to select

one.

View HTML documentation

Use Documentation P> View HTML documentation to view the
documentation of the active customized object. In contrast if you use Help P
OnLine, you get documentation on all submodels.
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4.3.8 Windows menu

Use the Windows menu to modify the display of your systems.

Figure 4.100: Windows menu

Windows Help
% LCascade

|T d:/ametest/tutonal/submodelzAMCARM B0

Claze all

Cascade

This option arranges the windows corresponding to the customized objects
currently used so that they overlap with their titles remaining visible.

List of currently opened files

This part of the Windows menu shows the list of currently opened files.

You can bring an object to the top by selecting it, it becomes the active object.
close all

This option initiates the process of closing all the windows associated with
customized objects. If there are unsaved changes, you will be asked to save
them.

4.3.9 Help menu

Figure 4.101: Help menu

Help

Onlne...  F1

? Ahout.

Online

Select this item to view the documentation of AMESim submodels. These may
be in libraries supplied as an AMESim product, generic or customized
submodels or supercomponents produced by you or by a colleague. At the left
side of the screen you can find the three following tabs:

» Contents, which shows the list of the documentation topics.

* Index, from which you can type in a keyword and get the related
entries.
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Search, from which you can get the list of all the documents contain-
ing at least one occurence of a given keyword.

Figure 4.102: On-line help window
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About

This option gives a lot of information on the version of AMECustom you are
using and the libraries to which you have access. If you contact the AMESim

hotline, you may need to give information from this dialog box to the support
team.

4.4 The AMECustom Toolbar

Each button of the toolbar is equivalent to a menu item of the menu bar.
Eﬁv" File > Open or Ctrl+O (see Open)

File P> Save or Ctrl+S (see Save)

ﬁ Previews P> Parameter mode (see Previews menu)

E Previews P> Run mode (see Previews menu)

.;H: Edit P Cut or Ctrl+X (see Edit menu)

Edit P> Copy or Ctrl+C (see Edit menu)
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Edit > Paste (see Edit menu)

F Edit » Trash can (see Edit menu)

5 The Category buttons

The category buttons are located at the left side of The AMECustom main
window. When you click on one of these, a dialog box of component icons
appears (Figure 4.103) which will be familiar with all users of AMESim,
AMERuUnN and AMESet.

Figure 4.103: Mechanical component icons dialog box

RS G

OB

| [

i

;1\

]

=o| e == =5 e =) 2

=g 0

u u ﬂ

4

— | Lineak | || [LivERR | L
HmecH  E| A MECH T
NODE NODE ALT. T

wo b

brvrd

T
In AMECustom, when you select one of these icons you get a Submodel List
dialog box (Figure 4.104).
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Figure 4.104: Submodel List dialog box

%3 Submodel List
cam2
O
—Subrodel lizt

Marme Dezcription Type &

E| CaMOD cam and cam follovwer generic zubmodel
! e EXCAMED carn and cam follower customized submodel
GEMSUPERCARMAD genenc supercomponent cam genenc supercamponent
CUSTOMCAMBT  geheric supercompohent cam cuztomized supercnmpnnent;l

Esternal variables Help Erplore |

Cancel |

&

This contains a list of generic and customized submodels and supercomponents
associated with the selected icon that AMECustom can find using the current
path list. You can select one item in this list.

* Click on OK to load the object into AMECustom. If it is encrypted,
you will be asked for a password.

Figure 4.105: You must know the password if the submodel is encrypted

E Enter Password (7| x|

Submodel iz protected.
Please enter the password to be able to uze it

] I Cancel

» The Explore button is sensitive only if it is a supercomponent. Click
on this to see the supercomponent constituents. If it is encrypted,
you will be asked for the password.

» Click on External variables to display the external variables of the
object.

» Ifyouclick on Help, AMECustom will attempt to load and display
documentation on the selected object.

* Click on Cancel if you have lost interest in the objects displayed.
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4.6 The customized object general features

4.6.1 General features of a submodel

These are shown on the left hand side of the AMECustom main window when
a submodel is selected for customization:

Figure 4.106: General features of the submodel

Name—.} ExCARGD
lcon —P= 25@31

Change icon

cam2

—_

L

Brief dezcription:

Icam and cam follower

Full dezcription

j

Some Right-click menus (page 90) are also available.
Name

When a new customized submodel is being created, AMECustom assigns a
default name to it. If the name of the associated generic submodel is
GENNAME, then the default name is UNNAMED GENNAME. The first time
you save your customized submodel, AMECustom asks you to replace the
default name by a new one. Submodel name conventions are discussed in the
introduction of Chapter 2:Customizing submodels (page 7) .

Icon

The default icon of a customized submodel is the same as the icon of the
generic submodel it is associated with. However you can change this using the
Change icon button:
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Figure 4.107: Select an icon
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This produces an Icon selection dialog box which allows you to select a
different icon. Note that you will be presented with subset of icons. These are
compatible with the active customized submodel. It is possible that no icons are
suitable! In this case you will have to create your own one. Naturally you must
create a new icon before attaching any customized submodel to it.

Brief description
This appears in an editable field which contains, by default, the generic
submodel description. You should replace this by the description of your
customized submodel.

Full description
If you click on the button labeled Full description, the dialog box below
appears. By default this shows the full description of the associated generic

submodel. You must alter it in order to take into account the modifications
done in your customized submodel.
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Figure 4.108: Full description dialog box

% Full Descrnption HE

I
TITLE : EXCAMS0

DESCRIFTIOM :
Thiz iz a submodel of an exhaust cam profile with cam follower.

ArASCH file iz read defining the inear dizplacement of the contact
point [in mm] according to the angular displacement (in degrees, in the
range 0 to 3E0). Note that in this file, the dizplacement at the first
angle value must be equal to the displacement at the last angle value.

On port 1 the outputs are the lingar speed in m/s and the dizplacement

it m, the input is a force in M. On port 2 the output iz a torgque in
Mm and the input iz a speed in rev/min.

Clear all I Genenc description Load default | From file |

ok | LCancel |

This dialog box also contains the four buttons described below:
* Clear all: delete the content of the description.

* Generic description: replace the text currently shown by the description of
the associated generic submodel.

* Load default: replace the text currently shown by a template containing the
headers TITLE, DESCRIPTION...

» From file: produce a file browser from which you can pick up a text file
containing a description. This could be a description of the specific
customized object you have produced in another editor or your own private
template that you prefer to use.

4.6.2 General features of a supercomponent

These are shown on the left hand side of the AMECustom main window when
a supercomponent is selected for customization:
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Figure 4.109: General features of the supercomponent
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Some Right-click menus (page 90) are also available.

Name, Icon, Brief description, Full description

These features are identical to the ones described in previous section.

List of constituents

80

This list contains two columns indicating the icon, the submodel name and the
type of each constituent (component, line or customized object) of the selected
supercomponent.

Note that when you select a constituent in this list, the table of the Internal
items is updated accordingly (see section The Internal items lists (page 92) ).

Below this list the Explore button produces a dialog box showing the circuit
associated with the supercomponent. If you click on a constituent of this circuit
then the corresponding line is selected in the list and the table of the /nternal
items is updated accordingly. AMECustom does not allow you to change
the circuit of a supercomponent.
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Figure 4.110: Circuit associated with the supercomponent

i Explore Supercomponent (7| x|

CUSVALYESS0-1

twin walves in a
cylinder head

Inlet Exhaust

4]

Euternal variablesl

Cloze |

The Explore Supercomponent dialog box also contains the following two
buttons:

» External variables: show the external variables of the supercomponent.

Figure 4.111: External variables of the supercomponent

F.g\:; External ¥ariables

CUSYVALVESS0

twin walves in a cylinder head

For vanabiss which have a diechion associaied with therm, a
Postiie sian s i e iscion of he Smow;

N

s rev/min

* Print: print the supercomponent circuit.

81



Chapter 4
Reference Guide for AMECustom

4.6.3 Right-Click Menus

* Main right-click menus

* Main functions available from the right-click menus
Main right-click menus

Different right-click menus are available from the main interface depending on
the part you click on.

Figure 4.112: the different right-click menus

PA AMECustom - [H:/MASD05]
“§ Fle Edt DOptions Previews lcons Toals Windows Help =

U

> &

a8 |

| UNMNAMED_MAS00E

|

[h = e-@-

—External it

Submodel global parameters:
Beal I Integer | Test
o [ ] 2| 3]
fiEIJ " Name ITllle IUnlt IM\nlmum walug | Default value
") O

L | mass_friction_ 3 n — i Add new

1 y Cut real global parameter
Hide all B i Cutreal global p J o— |
Show all = Copy real global parameter  —
Change icon

% |

i“ Paste real global parameter
E [ v [ =]
e - ¥ Bemove real global parameter lzte variable Kn‘:n -
jat Reset default value
k Unda Ciil+Z 4 Add new real global parameter
Eull desciption - E—"8 Hove up resl lobal parameter |——_ Reset nisl valie
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Y
Right-click on... to access the following commands...
. the left part of the display * hide all
» show all
the brief description * undo, redo last action
2 * cut, copy, paste, clear text

e select all text
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a submodel global parameter

cut, copy, paste real global parameter
remove, add new real global parameter

move up, move down real global
parameter

hide all, show all real global parameter

an external item title or value

reset default value, reset initial value
undo, redo
cut, copy, paste, clear

select all

an internal item

copy internal variable, paste internal or
external variable

hide, show all internal variables

Main functions available from the right-click menus

Modifying the brief description

If you right-click on the object brief description, a menu appears. This is
similar to the menu produced with most text (as opposed to numerical) fields
and it is shown in Figure 4.113. It contains items the function of which is
obvious. These menu items apply to the text in the Brief description field.

Figure 4.113: Right-click menu

Unda Chrl+Z
Bedo Chrl+y
Cut Clrl+
Copy Chl+C
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Clear

Select Al Crl+d,

Hiding status of variables and parameters

We can alter the status of an individual internal variable or parameter using the
special check boxes but often it is useful to operate on a whole group of
variables and parameters. We can do this using various right-click menus.

Figure 4.114: Hidden status check boxes

Hidden

[
-
|l
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Changing the hidden status of all variables and parameters of a custom-
ized submodel

When the object being customized is a submodel, the area below the Full
description button is blank but a right-click produces a menu. This can be used
to hide or show all parameters and internal variables of the current object.

Figure 4.115: Right-click menu in the Full description area

Brief dezcription:

Iinlet cam and cam follovwer

Full description |
Hide all
Show all
The same menu can be produced with a right-click in the internal item area.
Figure 4.116: A right-click menu is available in the internal item area

Internal items:

Internal variables IF!gaI parameters | Integer paramete

Title [ unit | Type
angular displacement of the cam degree explic
angular dizplac . . .

angular dizplacement o L-E] Ergy i) il
tramsformer ratio E Paste »

Hide all internal wariables

Show all intemal wariables

Changing the hidden status of all variables and parameters of a custom-
ized supercomponent

When the object being customized is a supercomponent, right-button menus
are available using:

+ the supercomponent tree structure,
» the Explore Supercomponent dialog box or
+ the internal item area.

For the supercomponent tree structure, select (highlight) an item in the tree
structure and operate the right button. If the selected item is the
supercomponent being customized (i.e. the root of the tree), the hide/show
applies to all the constituents. If the selected item is a constituent, it applies
only to this constituent.
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Figure 4.117: Show or hide the constituents
—Supercompanent
Submodel
, All constituents
Hide all
Shos all
L:a LCopy parameters
[ Paste parameters — Supercomponent
Subrmodel | Type
El- = CUSWALVE S50 SUpEIcomp
- ERCAMB0 cuztomized
-0 FOO0 companent
Selec?ed T .
constituent only o ING Hide al

LCO Show all
LCO

ETLST EY Copy parameters

- EZLST g

Easte parameters

M IE Eastep

For the Explore Supercomponent dialog box, if a constituent component is
selected as in Figure 4.118, a right-click menu applies only to the selected
component. If no component is selected, it applies to all constituent
components.

Figure 4.118: Right-click menu applied to a selected component

Component vanables and parameters  » Hide all

External variables Show all

Labels » Copy parameters
Bird's eye view Pazte parameters
Help |

You can also hide or show labels with this menu, get help on a constituent
component or get a bird’s eye view (for big supercomponents).

The right button menu for the Internal items area is active only if a constituent
component is selected and the result applies only to this component.

The global parameter lists

These lists show the global parameters currently defined for the selected
customized object (submodel or supercomponent). It contains the following
three tabs: Real, Integer, Text.
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Figure 4.119: Supercomponent global parameters

Supercomponent global parameters:

Beal I Integer | Text I

M arne I Title | Linit | Iirirnrm I Defaultl MaHimuml Hiddet |

WPRELOAD walve zpring preload m 200 300 g00W

WS TIFF valve zpring stiffness M/m 10000 100000 1e+006T t | ‘ |
WVCLEAR  walve clearance m Be-005 00001 Q00020

Add new |

WhASS valve mass kg 0.005 0o 0.0s-

WhALIFT - mawi pozsible walve.. m ooz 003 n.oss- Bemave |

You can:

* Add a global parameter by clicking on the Add new button after selecting
the tab associated with its type. When it is created, default values are
assigned to each of its characteristics.

* Delete a global parameter by clicking on the Remove button after selecting
it in the list.

*  Move up and down a global parameter using the arrow buttons. However,
when you save AMECustom does a check to ensure a variable is not
expressed in terms of another later in the list.

You cannot:

» Express a global parameter in terms of itself.

Real global parameters have the characteristics described below:

Name

Click on the column Name and type in a name for the real global parameter.
This name will be used in the column Default value of the External variables
or Internal items list.

Title

Click on the column Title and type in a title for the real global parameter. This
title is a short description of the parameter which will appear in AMESim.

Unit
Click on the Unit column and type in the unit of the real global parameter.

Alternatively you can click on the _I button in this column, and you will get
a dialog box for selecting the unit.
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Figure 4.120: Unit chooser dialog box

Unit Chooser E
Domain | |Init I;I

-- magretomative voltage
[ mass

- moment of inertia
[+- rotary acceleration

N
|

ka Find |

ok Cancel |

Minimum value, Maximum value and Default value

These characteristics are assigned by entering a value in the corresponding
column. If the three values are identical, the real global parameter will not
appear in AMESim and it will not be possible to change its value.

Hidden

Put a tick mark in this check box if you do not want this global parameter to be
available from the AMESIim Change parameters dialog box.

Integer global parameters have the characteristics described below:

Type

Select Standard or Enumeration. An enumeration parameter can have several
values and each value is associated with a text string. This association is done
in the Enumeration list column.

Name

Click on the column Name and type in a name for the integer global parameter.
This name will be used in the Default value column of the External variables
or Internal items list.

Title

Click on the Title column and type in a title for the integer global parameter.
This title is a short description of the parameter which will appear in AMESim.
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Enumeration list

This column is editable only if the type is set to Enumeration. Click on the _I
button in this column, and you will get a dialog box for defining and
associating each value of the parameter to a text string.

Figure 4.121: Configure Enumeration dialog box

*:' Configure Enumeration EE

Enwmeration list for 'mode for data out of range':

Yalue | Text I
1 extrapolation

extreme value

Add | Remove | ll Ll
Ok, | Cancel |

L0 ]
2
=N
=

Minimum value, Maximum value and Default value

These characteristics are assigned by entering a value in the corresponding
column for a standard parameter. If the three values are identical, the standard
integer global parameter will not appear in AMESim and it will not be possible
to change its value.

For enumeration integer global parameters, only the default value is required.

Hidden

Put a tick mark in this check box if you do not want this global parameter to be
available from the AMESim Change parameters dialog box.

Text global parameters have the characteristics described below:

Name

Click on the Name column and type in a name for the text global parameter.
This name will be used in the Default value column of the Internal items list
(in the tab labeled Text parameters).

Title

Click on the Title column and type in a title for the text global parameter. This
title is a short description of the parameter which will appear in AMESim.
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Default value

Click on this column and type in the text you want to assign. Often text
parameters are used to specify the full pathname of a file. In this case, you can

use the —I button to browse the default file instead of typing its name and path:

Figure 4.122: Browser of the Open dialog box

Lack jr: |'El Custam LI ﬁl

subrnodels
[#] camdemo?.ame
camdemDE_
|#] submodels.index

Flegame: | L D |
Files of type:  [Allfiles [* =l Cancel |

Hidden

Put a tick mark in this check box if you do not want this global parameter to be
available from the AMESim Change parameters dialog box.

Using global parameters

Global parameters of appropriate type can be assigned as default values
to:

* Any internal variable of the customized object, provided it has a
default value. This means it must be an explicit or implicit state, a fixed
variable or a constraint which is accessed in the Internal items area. The
global parameter must be of integer or real type. The original internal
variable will be hidden and the global parameter will appear in the Change
Parameters list.

* Any real, integer or text parameter of the customized object. In this
case, a tick mark is automatically added in the corresponding Hidden
column and this tick mark cannot be removed. This means that this item
will not appear in AMESim anymore, it will be replaced by the global
parameter.
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Figure 4.123: Real parameters tab

Internal items:

Internal varisbles | Real parameters Ilngeger paramneters | Text parameters |

Title [ unit [ inioum | Defaut [ Masimum | Hidden |
CRAMED-T: radius of crank mm 01 RaDIUS 10000
CRAMED-T: length of connecting rod mm nz LEMGTH 15000

CRAMED-1: offset for dizplacement  mm -1e+006 OFFSET 1e+0061V

* Any external variable of the customized object, provided it can be
assigned a default value. However, since external variables cannot be
hidden and both the global parameter and the external variable in its own
right will appear in the Change Parameters list. It is normally better to
customize an external variable in its own right rather than using a
global parameter.

Figure 4.124: External variables

External wariables:

Fort | Title | Lnit | Type | Wit | Default | b airum
1 welocity at part 1 miz  explicit state variable -1e+008 0 1e+006
1 dizplacement port 1 m explicit state variable de+006  DISPO Te+006
1 acceleration at port 1 mzfs vanable
1 force at port 1 M wariable
2 force at port 2 M wariable
Right-click menus
Title / Value

If you select the title or a value (Minimum, Default or Maximum) of a global
parameter and you right-click on it, a menu similar to the one shown in Figure
4.125 appears.

Figure 4.125: Right-click menu

Reset default walue
Reset initial vwalue
Undo Chil+Z
Eeda [Chrl#r*
Cut Chrl+
LCopy Chrl+C
Paste Chrl+"
Clear

Select Al Chrl+a,

This menu contains items which functions are obvious. They apply to the
selected title or value.
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The External variables list

This list shows the external variables of the customized object (submodel or
supercomponent) currently selected.

Figure 4.126: External variables list

Esternal wariables:

F'UltI Title I it | Type I P irimum | Default | b axirmuim
1 welocity at port 1 m#s  explicit state vanable  -1e+006 0 Te+10R
1 dizplacement port1  m ewplicit state variable  -1e+008 0 Te+10&
1 acceleration at port 1 mdsds variable
1 force at port 1 i variable
2 force at port 2 M vanahle

In this section, you can have information about:

External variable characteristics

Port

This column shows the port number associated with external variables. This
characteristic cannot be changed.

Title

This column shows the generic short descriptions of external variables. You are
allowed to modify them for customizing the object.

Unit

This column shows the unit associated with external variables. This
characteristic cannot be changed.

Type

This column shows the type of external variables. This characteristic cannot

be customized.

Minimum value, Maximum value and Default value

These characteristics are initially set to their generic values but you can modify
them for customizing the object. If the three values are identical for a given
external variable, it will not be possible to change its value in AMESim. The
default value can be assigned an integer or real global parameter.
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Right-click menus
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Title / Value

If you select the title or a value (Minimum, Maximum or Default) of an
external variable and you right-click on it, a pulldown menu similar to the one
shown in Figure 4.127 appears.

Figure 4.127: Right-click menu

Reset default walue
Reset initial vwalue

Undo Chil+Z
Eeda [Chrl#r*
Cut Chrl+
LCopy Chrl+C
Paste Chrl+"
Clear

Select All Chrly

This menu contains items the functions of which are obvious. They apply to the
selected title or value.

The Internal items lists

These lists show internal variables, real parameters, integer parameters and text
parameters currently defined for:

 the current customized submodel or
+ the selected constituent of the current customized supercomponent.

It contains four tabs: Internal variables, Real parameters, Integer parameters
and Text parameters.

Figure 4.128: Internal items list

Internal items:

Internal vanables IHgaI patarneters I Integer parameters | Test parameters |

Title | Lnit | Type | Minimuml Default I b &xirum | Hidden I
angular dizplacement of ... degree explicit state vanable ] 1] w0
angular dizplacement of ... degree multiine macro variable r
tranzformer ratio m rmulti-line macra variable r

In this section, you can have information about:
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Internal variables

Internal variables have the characteristics described below:

Title

This column shows the short descriptions of internal variables. They may
include a prefix to make the title unique. You are allowed to modify them for
customizing the object.

Unit

This column shows the unit associated with internal variables. This
characteristic cannot be changed.

Type

This column shows the type of external variables. This characteristic cannot
be changed.

Minimum value, Maximum value and Default value

These characteristics are initially set to their generic values but you can modify
them for customizing the object. If the three values are identical for a given
internal variable, it will not be possible to change its value in AMESim. The
default value can be assigned an integer or real global parameter.

Hidden

Put a tick mark in this check box if you do not want the selected internal
variable to appear in AMESim. This option is automatically selected if you
assign a global parameter to the internal variable.

Real parameters

Real parameters have the characteristics described below:

Title

This column shows the short descriptions of real parameters. They may include
a prefix to make the title unique. You are allowed to modify them for
customizing the object.

Unit

This column shows the unit associated with real parameters. This
characteristic cannot be changed.

Minimum value, Maximum value and Default value

These characteristics are initially set to their generic values but you can modify
them for customizing the object. If the three values are identical for a given real
parameter, it will not be possible to change its value in AMESim. The default
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value can be assigned an integer or real global parameter.

Hidden

Put a tick mark in this check box if you do not want the selected real parameter
to appear in AMESim. This option is automatically selected if you assign a
global parameter to the real parameter.

Integer parameters

Integer parameters have the characteristics described below:

Title

This column shows the generic short descriptions of integer parameters. You
are allowed to modify them for customizing the object.

Minimum value, Maximum value and Default value

These characteristics are set to their generic values but you can modify them
for customizing the object. If the three values are identical for a given integer
parameter, it will not be possible to change its value in AMESim. The default
value can be assigned an integer or real parameter.

Hidden

Put a tick mark in this check box if you do not want the selected integer
parameter to appear in AMESim. This option is automatically selected if you
assign a global parameter to the integer parameter.

Text parameters

94

Text parameters have the characteristics described below:

Title

This column shows the short descriptions of text parameters. They may include
a prefix to make the title unique.You are allowed to modify them for
customizing the object.

Default value

This characteristic is set to its generic value but you can modify it for
customizing the object. You can directly type in its value, or it can be assigned
a text global parameter. Often text parameters contain a file name associated

with a path. In this case, you can use the _I button to browse the default file
instead of typing its name and path:
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Figure 4.129: Browser of the Open dialog box

Open KHE

Loskire [y Custom =l &
submodels

[#] camdemo? ame

camdemDE_
[#] subrmodels.index

Files of type:  [Allfiles [* =l Cancel |

Hidden

Put a tick mark in this check box if you do not want the selected text parameter
to appear in AMESim. This option is automatically selected if you assign a
global parameter to the text parameter.

Right-click menus

Title / Value

If you select the title or a value (Minimum, Maximum or Default) of an internal
item and you right-click on it, a pulldown menu similar to the one shown in
Figure 4.130 will appear.

Figure 4.130: Right-click menu

Reset default walue
Reset initial vwalue

Undo Chil+Z
Eeda [Chrl#r*
Cut Chrl+
LCopy Chrl+C
Paste Chrl+"
Clear

Select Al Chrl+a,

This menu contains nine items the functions of which are obvious. They apply
to the selected title or value.

Hide/Show

If you right-click on any column title in the tab of an internal item, the
following menu appears:
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Figure 4.131: Right-click menu in the tab of an internal item

Hide all internal variables

Show all internal variables

This menu provides two facilities allowing you to hide or show all internal
variables displayed in the tab currently selected.
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Reporting Bugs and using the Hotline Service

AMECustom is a large piece of software containing many hundreds of thousands of
lines of code. With software of this size it is inevitable that it contains some bugs. Nat-
urally we hope you do not encounter any of these but if you use AMECustom exten-
sively at some stage, sooner or later, you may find a problem.

Bugs may occur in the pre- and post-processing facilities of AMESim, AMERun,
AMESet, AMECustom or in one of the interfaces with other software. Usually it is
quite clear when you have encountered a bug of this type.

Bugs can also occur when running a simulation of a model. Unfortunately it is not pos-
sible to say that, for any model, it is always possible to run a simulation. The integra-
tors used in AMECustom are robust but no integrator can claim to be perfectly
reliable. From the view point of an integrator, models vary enormously in their diffi-
culty. Usually when there is a problem it is because the equations being solved are
badly conditioned. This means that the solution is ill-defined. It is possible to write
down sets of equations that have no solution. In such circumstances it is not surprising
that the integrator is unsuccessful. Other sets of equations have very clearly defined
solutions. Between these extremes there is a whole spectrum of problems. Some of
these will be the marginal problems for the integrator.

If computers were able to do exact arithmetic with real numbers, these marginal prob-
lems would not create any difficulties. Unfortunately computers do real arithmetic to
a limited accuracy and hence there will be times when the integrator will be forced to
give up. Simulation is a skill which has to be learnt slowly. An experienced person will
be aware that certain situations can create difficulties. Thus very small hydraulic vol-
umes and very small masses subject to large forces can cause problems. The State
count facility can be useful in identifying the cause of a slow simulation. An eigenval-
ue analysis can also be useful.

The author remembers spending many hours trying to understand why a simulation
failed. Eventually he discovered that he had mistyped a parameter. A hydraulic motor
size had been entered making the unit about as big as an ocean liner! When this pa-
rameter was corrected, the simulation ran fine.

It follows that you must spend some time investigating why a simulation runs slowly
or fails completely. However, it is possible that you have discovered a bug in an
AMESim submodel or utility. If this is the case, we would like to know about it. By
reporting problems you can help us make the product better.

On the next page is a form. When you wish to report a bug please photocopy this form
and fill the copy. You telephone us, having the filled form in front of you means you
have the information we need. Similarly include the information in an email.

To report the bug you have three options:

» reproduce the same information as an email
* telephone the details

+ fax the form

Use the fax number, telephone number or email address of your local distributor.






HOTLINE REPORT

Creation date: Created by:
Company: Contact:
Keywords (at least one):

Problem type: O Bug
Summary:

Description:

Involved operating system(s):

O Al O Unix (all)
O HP

0O 1Bm

O saGl

O SUN

[ Other:

Involved software version(s):

OAIl O AMESim (all) O AMERun (all)
O AMESim 4.0 O AMERun 4.0
0 AMESim 4.0.1 0 AMERun 4.0.1

O AMESim 4.0.2
O AMESim 4.0.3
O AMESim 4.1

O AMESim 4.1.1
O AMESim 4.1.2
O AMESim 4.1.3

O AMESim 4.2

O AMERun 4.0.2
O AMERun 4.0.3
O AMERun 4.1

O AMERun 4.1.1
O AMERun 4.1.2
O AMERun 4.1.3

O AMERun 4.2

O Improvement

O PC (all)
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[ Other

[0 Windows 2000

[0 Windows NT

[0 Windows XP

O Linux

[ Other:

1 AMESet (all)
1 AMESet 4.0

O] AMESet 4.0.1
1 AMESet 4.0.2
1 AMESet 4.0.3
1 AMESet 4.1

O AMESet 4.1.1
O] AMESet 4.1.2
O] AMESet 4.1.3

O AMESet 4.2

[0 AMECustom (all)
O AMECustom 4.0

O AMECustom 4.0.1
O AMECustom 4.0.2
O AMECustom 4.0.3
O AMECustom 4.1

O AMECustom 4.1.1
O AMECustom 4.1.2
O AMECustom 4.1.3

[0 AMECustom 4.2
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